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Preface

Safety information

Safety alert words

MSDSs

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide

Note: For general safety information, see this Preface and Appendix B, “Safety” on
page 89. When a hazard symbol and hazard type appear by a chemical name or
instrument hazard, see the “Safety” Appendix for the complete alert on the chemical or
instrument.

Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular
level of observation or action, as defined below:

IMPORTANT! — Indicates information that is necessary for proper instrument
operation, accurate chemistry Kit use, or safe use of a chemical.

ﬁ CAUTION! - Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

WARNING! - Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

DANGER! - Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury. This signal word is to be limited to the most
extreme situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard symbols that are affixed to Applied Biosystems
instruments (see “Safety symbols” on page 90).

The MSDSs for any chemicals supplied by Applied Biosystems or Ambion are
available to you free 24 hours a day. For instructions on obtaining MSDSs, see
“MSDSs” on page 97.

IMPORTANT! For the MSDSs of chemicals not distributed by Applied Biosystems or
Ambion contact the chemical manufacturer.

Vii
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About this guide

Safety labels on
instruments

the preceding section.

The following CAUTION, WARNING, and DANGER statements may be displayed on
Applied Biosystems instruments in combination with the safety symbols described in

Hazard
symbol

English

Francais

/N

CAUTION! Hazardous chemicals. Read the Material
Safety Data Sheets (MSDSs) before handling.

CAUTION! Hazardous waste. Refer to MSDS(s) and
local regulations for handling and disposal.

ATTENTION! Produits chimiques dangereux. Lire
les fiches techniques de slreté de matériels avant
toute manipulation de produits.

ATTENTION! Déchets dangereux. Lire les fiches
techniques de sireté de matériels et la régulation
locale associées a la manipulation et I’élimination
des déchets.

WARNING! This instrument is designed for 12 V, 75
W Halogen lamps only.

WARNING! Hot lamp.

AVERTISSEMENT! Cet instrument est congu pour
des lampes d'halogéne de 12 V et 75 W seulement.

AVERTISSEMENT! Lampe brilante.

WARNING! Hot. Do not remove lamp until 15 min
after disconnecting supply.

AVERTISSEMENT! Lampe brillante, aprés avoir
déconnecté le cable d’alimentation de I'appareil,
attendre environ 15 minutes avant d’effectuer un
remplacement de la lampe.

WARNING! Hot. Replace lamp with an
Applied Biosystems lamp.

AVERTISSEMENT! Composants brialants.
Remplacer la lampe par une lampe
Applied Biosystems.

CAUTION! Hot surface.
DANGER! High voltage.

ATTENTION! Surface brilante.
DANGER! Haute tension.

/AN

WARNING! To reduce the chance of electrical
shock, do not remove covers that require tool
access. No user-serviceable parts are inside. Refer
servicing to Applied Biosystems qualified service
personnel.

AVERTISSEMENT! Pour éviter les risques
d’électrocution, ne pas retirer les capots dont
I’ouverture nécessite I'utilisation d’outils.
L’instrument ne contient aucune piece réparable par
I’utilisateur. Toute intervention doit étre effectuée par
le personnel de service qualifié venant de chez
Applied Biosystems.

£\

CAUTION! Moving parts. Crush/pinch hazard.

ATTENTION! Piéces en mouvement, risque de
pincement et/ou d’écrasement.

About this guide

Assumptions

viii

This guide assumes that you:

*  Are familiar with the Microsoft Windows® operating system.

e Are familiar with the Internet and Internet browsers.

*  Know how to handle DNA samples and prepare them for PCR.

» Understand data storage, file transfer, and copying and pasting.

* Have networking experience, if you plan to integrate the 7500 Fast system into
your existing laboratory data flow.

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide
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How to use this guide

Text conventions  This guide uses the following conventions:

Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

Italic text indicates new or important words and is also used for emphasis.
For example:

Before analyzing, always prepare fresh matrix.

A right arrow symbol ( » ) separates successive commands you select from a drop-
down or shortcut menu. For example:

Select File » Open » Spot Set.
Right-click the sample row, then select View Filter » View All Runs.

User attention  Two user attention words appear in Applied Biosystems user documentation. Each
words  word implies a particular level of observation or action as described below:

Note: — Provides information that may be of interest or help but is not critical to the
use of the product.

IMPORTANT! — Provides information that is necessary for proper instrument
operation, accurate chemistry kit use, or safe use of a chemical.

How to obtain support

For the latest services and support information for all locations, go to:

www.appliedbiosystems.com

At the Applied Biosystems web site, you can:

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide

Access worldwide telephone and fax numbers to contact Applied Biosystems
Technical Support and Sales facilities.

Search through frequently asked questions (FAQs).
Submit a question directly to Technical Support.

Order Applied Biosystems user documents, MSDSs, certificates of analysis, and
other related documents.

Download PDF documents.
Obtain information about customer training.

Download software updates and patches.


http://www.appliedbiosystems.com
http://www.appliedbiosystems.com

Preface
How to obtain support
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Chapter 1

Get Started

Chapter 1 This chapter covers:

B About the MicroSEQ Mycoplasma detection system. . .................... 2
Get Started

B About the AccuSEQ Software .. ........ ... ... . ... . ... .. 2
I B About Mycoplasma SEQ experiments . .. ............ouviiiirnrnnann.. 2
B Howtousethisguide ........ ...t 4
B About the example Mycoplasma SEQ experiment. ... .................... 5
Set Up the Experiment B Example experiment workflow. ....... ... ... .. . L i 8

Note: For more information about any of the topics discussed in this guide, access the
Help system by pressing F1, by clicking @ in the toolbar of the AccuSEQ Software
window, or by selecting Help » Contents and Index.

Prepare the Reactions

Run the Experiment

Review the Results Summary

(Optional) Review the Results

(Optional) Investigate the
Results

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide
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About the MicroSEQ Mycoplasma detection system

About the MicroSEQ Mycoplasma detection system

Components of the MicroSEQ® Mycoplasma Detection System include:

+ Software — AccuSEQ"" Real-Time PCR Detection Software
+ Instrument — Applied Biosystems 7500 Fast Real-Time PCR System
* Reagents —

— PrepSEQ"™ Mycoplasma Nucleic Acid Extraction Kit

—  MicroSEQ® Mycoplasma Real-Time PCR Detection Kit

About the AccuSEQ Software

Applied Biosystems AccuSEQ Software is detection and analysis software used with
Real-Time PCR (polymerase chain reaction) assays for impurity and contaminant
analysis in pharmaceutical quality control and process development environments.

The Applied Biosystems AccuSEQ Software v1.0 features include:

* Support for Applied Biosystems 7500 Fast Real-Time PCR Systems — The
AccuSEQ software allows you to set up, run, and analyze experiments using the
7500 Fast instrument with two workflows:

— SEQ Experiment Workflow — To set up, run, and analyze Mycoplasma
experiment samples prepared with the MicroSEQ® Mycoplasma Real-Time
PCR Detection Kit.

— Custom Experiment Workflows — To set up, run, and analyze your own
standard curve, melt curve, or presence/absence experiments.

* Quality and results summaries — Provide results in graphical and tabular format.

* Security, Audit, and Electronic Signature (SAE) Module — Allows the
AccuSEQ Software Administrator to control access to the software and determine
auditing and electronic signature requirements.

* Instrument Maintenance Manager — Provides step-by-step instructions for
performing instrument calibration and verification runs.

About Mycoplasma SEQ experiments

Mycoplasma SEQ experiments are presence/absence experiments that include a melt
curve. Perform a Mycoplasma SEQ experiment to detect the presence of Mycoplasma
species DNA in a sample.

Note: In this guide, the term experiment refers to the entire process of performing a
run using the 7500 Fast system, including setup, run, and analysis.

About the The Mycoplasma SEQ experiment workflow is designed to set up, run, and analyze

Mycoplasma SEQ  samples prepared with the MicroSEQ Mycoplasma Real-Time PCR Detection Kit.
experiment

workflow The Mycoplasma SEQ experiment workflow:

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide



Chapter 1 Get Started 1
About Mycoplasma SEQ experiments

* Creates an experiment to detect the presence of Mycoplasma species DNA in a
sample.
* Allows you to:
— Specify the number of samples and controls
— Enter sample names
— Specify sample volume per reaction
» Provides a suggested plate layout, but allows you to modify the plate layout.
* Generates a reaction set-up worksheet and plate layout diagram that includes
reagent volumes needed and optional instructions for preparing samples.
* Includes optimized thermal-cycling settings.
* Provides a summary of sample and control results.

» Provides detailed call assessments and troubleshooting suggestions for
inconclusive or unexpected results.

+ Provides results reports that you can print, or save as pdf (Adobe® Acrobat®),
html, ppt (Microsoft PowerPoint®), or xIs (Microsoft Excel®).

About the The Mycoplasma Real-Time PCR Detection Kit is designed for routine screening and
Mycoplasma Real - detection of Mycoplasma species (mycoplasmas) and other closely related species such
Degg%ﬁiﬁ as Acholeplasma laidlawii and Spiroplasma citri. Based on SYBR® Green dye
technology, this assay is optimized for broad detection of mycoplasmas. When used

with the recommended sample preparation, this assay provides the specificity and
sensitivity needed for routine use in the monitoring of cell lines, raw materials, and
biopharmaceutical product-manufacturing.

About the PCR  For a Mycoplasma SEQ experiment, you prepare PCR reactions that contain multiple
reactions  primers designed to amplify the mycoplasma targets and a reagent to detect
amplification of the targets in unknown samples.

The reactions required in a Mycoplasma SEQ experiment are:

*  Unknown — A DNA sample from media, cell culture, or other source that you are
testing for the presence of mycoplasmas.

* Negative Control — A reaction solution that contains water or buffer instead of
sample template.

* Positive Control (Mycoplasma Real-Time PCR DNA Control) — A specially
designed plasmid DNA used as the positive control whose amplification mimics
the expected amplification of a target.

+ Inhibition Control — A reaction solution that includes the Power SYBR® Green

PCR master mix, the unknown sample, and the positive control (Mycoplasma
Real-Time PCR DNA control).

About the run  In Mycoplasma SEQ experiments, the run method is pre-determined by the AccuSEQ
method  software and is not editable. The run method includes the following stages:

* Holding — In the thermal profile for a Mycoplasma SEQ experiment, a stage that
includes a single step. The holding stage is performed on the 7500 Fast instrument
before PCR amplification to activate the AmpliTaq Gold® enzyme.

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide
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How to use this guide

* Cycling (Amplification) — Part of the run method in which PCR produces
amplification of the target. The amplification stage is performed on the 7500 Fast
instrument.

*  Melt (Dissociation) curve — In the thermal profile for a Mycoplasma SEQ
experiment, a stage with a temperature increment to generate a melt curve that is
required to determine the results for the experiment. The melt curve stage is
performed on the 7500 Fast instrument after PCR amplification to collect
endpoint fluorescence data.

Fluorescence data collected during the run method are stored in an experiment data file
(*.eds).

About the analysis  Data collected from the run method are used to automatically determine Mycoplasma
SEQ experiment presence/absence calls. The results are reported in the following
screens:

* Results Summary — Provides a summary of expected, unexpected, present,
absent, and inconclusive results, and displays results in plate view or table view.

* Quality Summary — Provides a description and troubleshooting information for
inconclusive results in the Results Summary.

* Plot Analysis — Amplification Plot, Melt Curve, Multicomponent Plot, Raw Data
Plot, and Multiple Plots View can be used to further investigate results, modify C
settings, and re-analyze the data.

For more For information on:

information . .
* Mpycoplasmas, and the Mycoplasma assay and detection kit — Refer to the

MicroSEQ® Mycoplasma Real-Time PCR Detection Kit Protocol.

* The 7500 Fast system and supported consumables — Refer to the Applied
Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide.

+ SYBR® Green dye technology — Refer to the Applied Biosystems Real-Time PCR
Systems Reagent Guide.

+ Custom experiments (standard curve, presence/absence, and melt curve) — Refer
to the AccuSEQ Real-Time PCR Detection Software Custom Experiments Quick
Reference Card.

How to use this guide

Using this guide as  Using example experiment data provided with the AccuSEQ software, you can use this
atutorial  guide as a tutorial for performing a Mycoplasma SEQ experiment on a 7500 Fast
system. For the example experiment, follow the procedures in chapters 2 through 7:

Chapter Procedure

2 Set up the experiment using the SEQ Experiment workflow in the AccuSEQ
software.

4 AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide
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About the example Mycoplasma SEQ experiment

Chapter Procedure

3 Prepare the experiment, using the reagents and volumes calculated by the
SEQ Experiment workflow in Chapter 2.

Run the experiment on a 7500 Fast instrument.

Review the Results Summary.

(Optional) Review the analysis results.

N o o b

(Optional) Investigate the analysis results.

For more information, see “About the example Mycoplasma SEQ experiment” on
page 5.

Using this guide  After completing the tutorial exercises in chapters 2 through 7, use this guide to lead
with your own  you through your own Mycoplasma SEQ experiments. Each procedure in Chapters 2
experiments through 7 includes a set of guidelines, marked with the heading Guidelines for your
experiment, that you can use to perform your own experiments.

Additionally, you can use one of the other workflows provided in the AccuSEQ
software to perform your experiments. The table below provides a summary of all the
workflows available in the AccuSEQ software.

Workflow Description See...
SEQ Set up a new experiment for specific Applied Biosystems = Chapter 2
Experiment SEQ assay(s) with guidance from the software,

recommended for new users. The SEQ Experiment
workflow calculates reagent volumes, determines
optimum plate setup, guides you through experiment set
up, uses optimized thermal cycling conditions, and
performs data analysis.

SEQ Set up a new SEQ experiment using setup information Appendix A
Template from a template.

Custom Set up a new experiment using advanced options, Documentation
Experiment recommended for experienced users. The Custom

Experiment workflow allows design flexibility as you
create your own experiment.

Note: An experiment you create in the SEQ experiment workflow cannot be accessed
from the custom experiment workflow.

About the example Mycoplasma SEQ experiment

To illustrate how to perform Mycoplasma SEQ experiments, this guide leads you
through the process of designing, preparing, running and analyzing an example
experiment. The example experiment represents a typical setup that you can use to
quickly familiarize yourself with a 7500 Fast system running AccuSEQ software.

Description  The objective of the example Mycoplasma SEQ experiment (example experiment) is to
detect the presence of Mycoplasma species DNA in each test sample.

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide 5
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About the example Mycoplasma SEQ experiment

In the example experiment:

+ DNA is extracted from samples using the PrepSEQ"™ Mycoplasma Nucleic Acid
Extraction Kit.

* The target is the bacteria being tested (mycoplasmas).

» Each reaction in the experiment contains multiple primer sets that are designed to
amplify the same target sequence from different species and SYBR® Green I dye
to detect the dsDNA products generated during PCR.

Reaction plate The AccuSEQ software displays the 96-well reaction plate layout as shown below:

1 | 2 | 3 | [ | 5 | [ | 7 | ] | 9 | 10 | 11 | 12
. Sample 1 Sample 1 Sample 1 Sample & Sample 4 Sample 4 Sample 7 Sample 7 Sample 7 Sample 10 Sample 10 Sample 10
m m m m m m
. Sample 2 Gample 2 Sample 2 Sample § Sample 5 Gample 5 Sample & Sample Sample s Sample 11 Sample 11 sample 11
U m m U | U] o
o Sample 3 Sample 3 Sample Sample 8 Sample Sample Sample Sample Sample Sample 12 Sample 12 Sample 12
U] o U] @ (U] o
D
E
F
[}
POS 1 O3 1 HES 1 HEG 1
™ B Mycoptasma .. [ Mycopiasma [ Mycopizsma ... [ Mycapiasma
‘Wells: [ Unknown 24 [ Negative Control 2 [ Positive Control 2 Inhibition Control 12 56 Empty

About the example In this getting started guide, you will use two files:
experiment data

files * In Chapter 2, you will create an example Mycoplasma SEQ experiment that
contains setup data, then you will save the file to your computer.

* In Chapter 5, you will view results in an example Mycoplasma SEQ experiment
file that contains run data. The data file for the example experiment installs with
the AccuSEQ software.

You can find the data file for the example experiment on your computer at <drive>:\
Applied Biosystems\AccuSEQ\experiments\Mycoplasma SEQ Example.eds, where
<drive> is the computer hard drive on which the AccuSEQ software is installed.

The experiments folder of the AccuSEQ software contains several example files that
you can reference when analyzing your own data. The following example files install
with the AccuSEQ software:

* Mycoplasma SEQ Example.eds

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide
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About the example Mycoplasma SEQ experiment

* Presence Absence Example.eds
» Standard Curve Example.eds

Note: Be sure to use the Mycoplasma SEQ Example.eds file when you perform the
procedures in this guide.

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide 7
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Example experiment workflow

Example experiment workflow

The figure below shows the workflow for the example Mycoplasma SEQ experiment.

Set Up the Experiment (Chapter 2)

* Create a new experiment.

* Define the experiment properties.

* Set up the samples and controls.

* (Optional) Review the run method.

* Print the experiment and reaction setup.
* Finish the experiment setup.

) 4
Prepare the Reactions (Chapter 3)

* Prepare the DNA template.
* Prepare the samples.

* Prepare the controls.

* Prepare the premix solution.

* Prepare the reactions.

Run the Experiment (Chapter 4)

* Prepare for the run.

* (Optional) Enable the notification settings.
» Start the run.

* (Optional) Monitor the run.

¢ Unload the instrument.

Review the Results Summary (Chapter 5)

* Review the Results Summary.

* Export and print the data.

b 4
(Optional) Review the Results (Chapter 6)

* Review the Quality Summary.
* Review the Amplification Plot.

¢ Review the Melt Curve.
¢ Review the table data.
* Export and print the data.

(Optional) Investigate the Results (Chapter 7)

* Review the Mulicomponent Plot.
* Review the Raw Data Plot.
* Review the analysis settings.

Omit wells from the analysis.

8 AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide



Chapter 2

Set Up the Experiment

This chapter covers:

I B Chapter OVEIVIEW . . ..ottt ettt e e e e e e e e et 10

B Create anew eXPEeriMeNt. . . ..o v vttt ettt ettt e et e eeen e, 12

B Define the experiment properties . .. ........vrvr e, 13

l B Setupthe samplesandcontrols .. ............. .. ... ... 15

Chapter 2 B (Optional) Review therunmethod . .. ....... .. ... .. ... ... ... ... ..... 20

Set Up the Experiment B Print the experiment and reaction SEtUP . . .. .. ...ttt 21
B Finish the experiment setup . ......... ... . 22

I Note: For more information about any of the topics discussed in this guide, access the

Help system by pressing F1, by clicking @ in the toolbar of the AccuSEQ Software
window, or by selecting Help » Contents and Index.

Prepare the Reactions

Run the Experiment

Review the Results Summary

(Optional) Review the Results

(Optional) Investigate the
Results

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide 9
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Chapter 2 Set Up the Experiment

Chapter overview

Chapter overview

About predefined
settings

For more
information

This chapter explains how to use the SEQ Experiment workflow in the AccuSEQ
software to set up the example Mycoplasma SEQ experiment. The SEQ Experiment
workflow provides a step-by-step workflow for a specific Applied Biosystems SEQ
assay. The SEQ experiment workflow calculates reagent volumes, determines optimum
plate setup, guides you through experiment set up, uses optimized thermal cycling
conditions, and performs data analysis.

Note: An experiment you create in the SEQ experiment workflow cannot be accessed
from the custom experiment workflow. When you design your own experiments, you
can select alternate workflows (see “Using this guide with your own experiments” on

page 5).

For the example experiment, the SEQ workflow guides you through Applied
Biosystems recommended best practices as you enter design parameters to set up, run,
and analyze Mycoplasma experiment samples prepared with the MicroSEQ®
Mycoplasma Real-Time PCR Detection Kit. Based on the Mycoplasma SEQ assay you
select, the following settings are pre-defined by the software and are not editable:

+ The experiment type is presence/absence.

* The run method includes three stages: holding, cycling, and melt curve.

* The reaction volume per well is 30 pL.

+ SYBR® Green dye is the reporter dye.

* A minimum of one of each of the following sample types are included in the plate
layout: unknown sample, inhibition control (one per sample), positive control, and
negative control.

For more information on:
Consumables — Refer to the Applied Biosystems 7500/7500 Fast Real-Time PCR
System Maintenance Guide.

*  SYBR Green reagents and PCR — Refer to the Applied Biosystems Real-Time PCR
Systems Reagent Guide.

» Using the Custom Experiment workflow — Refer to the AccuSEQ Real-Time PCR
Detection Software Custom Experiments Quick Reference Card.

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide
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Chapter overview

Example The workflow for setting up an experiment similar to the example experiment provided

experiment  with this getting started guide is shown below.
workflow

Start Experiment
v
Set Up the Experiment (Chapter 2)

1. Create a new experiment.

2. Define the experiment properties.
3. Set up the samples and controls.

4. (Optional) Review the run method.

5. Print the experiment and reaction setup.

<

Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v
Review the Results Summary (Chapter 5)

v
(Optional) Review the Results (Chapter 6)
v
(Optional) Investigate the Results (Chapter 7)
v
End Experiment

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide 11
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Create a new experiment

Create a new experiment

Create a new experiment using the SEQ Experiment workflow in the AccuSEQ
software.

1. Double-click »} (AccuSEQ Software).
2. Enter your user name and password, then click OK.

Note: See your system administrator for user name and password.

3. Inthe Home screen, click Create SEQ Experiment to open the SEQ Experiment
workflow.

A Home

4. In the SEQ assay selection dialog, verify that Mycoplasma Assay Software
Module v1.0 is selected from the presence/absence assay group, then click Next.

12 AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide
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® Which installed SEQ assay(s) do you want to run?

a Selectone or maore available SEQ assays within an assay group. To select an assay from another

group, deselect all assays from the first aroup, then select from the new group. YWhen you are
finished, click "Mext"

PresencelAbsence

Assay Group

| et == ‘ Cancel

Note: The SEQ assays shown in this dialog may vary, depending on the valid SEQ
assays installed on your system.

Define the experiment properties

About the example
experiment

Complete the
Experiment
Properties screen

In the Experiment Properties screen, enter identifying information for the experiment,
and verify the assay information to use.

In the example Mycoplasma SEQ experiment:

» The experiment is identified as an example.
+ The SEQ experiment type is presence/absence.
» The SEQ assay used is Mycoplasma Assay Software Module v1.0.

Note: The SEQ experiment workflow automatically specifies the setup information
(experiment type, reagents, targets) and an optimized run method for the selected assay.

1. Click the Experiment Name field, then enter Mycoplasma SEQ Example
Setup.

Note: The experiment header updates with the experiment name you entered.

2. Leave the Barcode field empty.

3. Click the Comment field, then enter Mycoplasma Getting Started Guide
Example.

4. Verify the SEQ experiment type and assay to use in the example experiment:
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Chapter 2 Set Up the Experiment

Define the experiment properties

SEQ Experiment Type — Presence/Absence. The SEQ experiment type
indicates the category of experiment automatically specified when you select
the SEQ assay to use. A SEQ presence/absence experiment detects the
amplification of targets.

IMPORTANT! The SEQ presence/absence experiment is customized for
detection of specific organisms and species and may yield different results
than a custom presence/absence experiment.

SEQ Assay(s) Used — Mycoplasma Assay Software Module v1.0. The SEQ
assay used indicates the organism detected by the assay.

5. Click Next.

Experiment: Mycoplasma SEQ Examp...

Experiment Properties

a Enter an experiment name, enter a comment {optionaly, then click "MNext" to continue.

How do you want to identify this experiment?

Experiment Mame: |Mycop|asma SEQ Example Setup

Barcode (Optionaly: |

Comment (Optional):  wycoplasma Getting Started Guide Example

SEQ Experiment Type: PresencelAbhsence

experiment

SEQ Assay(s) Used:  Mycoplasma Assay Software Module v1.0

When you set up your own Mycoplasma SEQ experiment:

Enter an experiment name that is descriptive and easy to remember.

Note: The experiment name is used as the default file name.

* (Optional) Enter a barcode to identify the barcode on the reaction plate.

* (Optional) Enter comments to describe the experiment.

For more For more information on:

information

Completing the Experiment Properties screen — Access the AccuSEQ Software
Help by clicking @ or pressing F1.

» Mycoplasma experiments — Refer to the MicroSEQ™ Mycloplasma Real-Time
PCR Detection Kit Protocol.
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Set up the samples and controls

In the Sample Setup screen, enter the number of samples, replicates, and controls to
include in the reaction plate, enter the sample and control names, then select which plot
color to assign to each sample and control.

The AccuSEQ software uses the sample information that you enter in the Sample Setup
screen to fill the wells in the plate layout (see page 16) and to calculate the required
reaction component volumes for each sample type, based on the MicroSEQ
Mpycoplasma Real-Time PCR Detection Kit Protocol guidelines.

About the example The example Mycoplasma SEQ experiment uses:

experiment
P + Twelve samples, where the presence/absence of the target (a mycoplasma

contaminant) is unknown.

+ Two Unknown sample replicates. Replicates are identical to the sample reactions,
containing identical components and volumes.

* One Inhibition Control replicate for each sample. Each Inhibition Control
replicate contains positive control template (Mycoplasma Real-Time PCR DNA
Control) and sample template.

» Two Positive Control replicates. Replicates contain positive control template
(Mycoplasma Real-Time PCR DNA Control) instead of sample template.

» Two Negative Control replicates. Replicates contain water instead of sample
template.

Complete the 1. In the Mycoplasma Module vI.0 column of the How many samples and controls

Sample Setup do you want to run? table, specify the number of samples and sample volume.
screen

a. Specify the number of samples and replicates:

For Number of...¥ Enter...S
Samples 12
Sample replicates 2
Inhibition control replicates for each sample 1
Positive control replicates 2
Negative control replicates 2

I At least one positive control, one negative control, and one inhibition control are
required.
§ The number that you specify is listed below in the sample type list (see step 2).

b. Set the Sample volume per reaction (2-10uL) to 10.

2. Leave the defaults in the Define Samples for Assay: Mycoplasma Module v1.0
table:

a. Sample Names for samples with Sample Type = UNKNOWN:
+ Sample 1
*  Sample 2
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View the plate
layout

* Sample 12

Define Samples for Assay: Mycoplasma Module v1.0 - 40 Wells

Sample Type Sample Name |m Flot Color | Mumber of Wells- | Mumber of wells -
Sample Inhibition Contrals
o T [gample 1 | v 2 1 2
[0 unKHOwN [sample 2 | v 2 1
[0 unKHOwN [sample 3 | v 2 1
[ unkrnowr [sample 4 | v 2 1 _
[ unkHowr [sample 5 | v 2 1
[ UNKN QWK [sample 6 | v 2 1
I UNKNOWH [gample 7 | v 2 1 »

b. Sample Names for samples with Sample Type = POS and NTC:
« POS1
* NEG1

c. Colors in the Plot Color drop-down lists.

Note: The plot color represents the amplification plot data in the software
and does not correspond to the dye color in the chemistry.

3. Click Next.

The AccuSEQ software automatically selects locations for the wells in the reaction
plate based on the sample setup information you entered in the Sample Setup screen
(see page 15). You can view and edit the plate layout before starting an instrument run.
For the example experiment, use the following procedure to view the plate layout and
move pairs of samples to new well positions by swapping their well locations.

1. Click (Setup » Plate Layout) in the navigation pane, if not already selected.

2. Review the initial well selections in the Plate Layout screen. In the Mycoplasma
SEQ experiment, the wells are arranged as shown:
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Set up the samples and controls

Sample 1 Sample 2 Sample 3 Sample 4 Sample 5 Sample & Sample 7 Sample 8 Sample @ Sample 10 Sample 11 Sample 12

Mycoplasma Mycoplasma Mycoplasma Mycoplasma Mycoplasma Mycoplasma Mycoplasma Mycoplasma Mycoplasma Mycoplasma Mycoplasma Mycoplasma

=

Sample 1 Sample 2 Sample 3 Sample 4 Sample & Sample & Sample 7 Sample & Sample @ Sample 10 Sample 11 Sample 12

Mycoplzsma . Mycoplasma ... Mycoplzsma . Mycoplasma .. Mycoplzsma . Mycoplasma .. Mycoplzsma . Mycoplasma .. Mycoplzsma . Mycoplasma .. Mycoplzsma .. Mycoplasma ...

m

Sampla 1 Sample 2 Sample 3 Sample 4 Sample 5 Sample® Sample 7 Sample® Sample g Sample 10 Sample 11 Sample 12
Mycoplssma Mycoplasma Mycoplssma Mycoplasma Mycoplssma Mycoplasma Mycoplssma Mycoplasma Mycoplssma Mycoplasma Mycoplssma Mycoplasma

e}

D
E
F
G
POS 1 POS 1 NEG 1 NEG 1
H & Mycopizsma .. [ Mysoplazma [ Myeopizsma ... [] Mysoplasma
37* Wells: [ Unknown 24 [Z] Negative Control 2 [E Positive Control 2 Inhibition Control 12 56 Empty

By default, the software:

* Groups Unknown sample and Inhibition Control replicates in columns,
starting with well Al.

» Assigns Positive Control and Negative Control replicates to the last well row
(wells H1-H12).

3. In the Wells pane, make sure there are:
e 24 Unknowns
* 12 Inhibition Controls
2 Positive Controls [
« 2 Negative Controls [.]

Note: If the plate layout is incorrect, click Previous and check your entered
values.

4. In the Plate Layout pane, swap well contents:
a. In the Group Wells By drop-down list, verify that Columns is selected.

b. Swap the well contents for the following pairs of wells:
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For Samples... Swap well... With well...
1t03 A2 B1
A3 C1
B3 Cc2
4106 A5 B4
A6 C4
B6 C5
7to9 A8 B7
A9 C7
B9 C8
10to 12 A1 B10
A12 Cc10
B12 C11

To swap the well contents for a pair of discontinuous wells in the plate layout,
press the Ctrl key while you click the desired wells, right-click the plate
layout, then select Swap.

1 2

Sample 1 Sample 2 Sam

m Mycoplasma ... m Mycoplasma ... m Pyizo!

Zaom In

Zaom Ot

Sample 1 Fit Plate

L% |
m yooplasma EIT‘
by

Full Screen
Sample 1

Mycoplasma ...

Save As

Print Preview

L Print

c. View the final plate layout:
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=

o

Wiel

Sample 1 Sampls 1 Sample 1
[T Mymopiasma .. [T Mycopiasma Mysoplasma .. [ Mysoplasma ... [1] Mysoplasma Mycopiasma ... [ Mysoplasma .. [ Mycopiasma Mysoplasma .. [ Mysoplasma ... [1] Mysoplasma Mycoplasma

Sample 2 Sample 2 Sample 2
L] myeapiazma ... [ Mycopiasma .. wycopliazma ... [ Mycopiasma .. [L] mycoplazma ... Mycoplasma ... |1 Mycoplasma ... [ Mycopiasma .. mycoplazma ... [ Mycopiasma ... (1] mycopliazma ... Mycoplsma .

Sample 3 Sample 3 Sample 3
[ mycopiasma ... [T Mysopliasma Mycoplasma ... [T Mycopiasma ... [T Mysoplasma Mycoplasma ... [ Mysoplasma ... [ Mysoplasma Mycoplasma ... [T Mycopiasma .. [ Mysoplasma Mycoplsma

POS 1 POS 1

& Mymopiasma . [ Mycopiasma

Ils: [ Unknown 24 [ Negative Control 2

Sample 4 Sample 4 Sample 4 Sample 7 Sample 7 Sample 7 Sample 10 Sample 10 Sample 10

Sample & Sample & Sample & Sample & Sample & Sample & Sample 11 sample 11 Sample 11

Sample & Sample B Sample & Sample 9 Sample 9 Sample 9 Sample 12 Sample 12 Sample 12

HEG 1 NEG 1
[ Mycoplasma . [1] Myopiasma

[ Positive Control 2 Inhibition Control 12 56 Empty

Guidelines for your

5.

6.

experiment

(Optional) Review the run method (see page 20).

Note: The SEQ experiment workflow automatically specifies an optimized run
method for the selected assay.

Click Next.

When you set up your own Mycoplasma SEQ experiment:

Identify each sample with a unique name and color.
Enter the number of samples and controls to set up in the reaction plate.

IMPORTANT! Use at least one negative and one positive control per run, and at
least one inhibition control per sample.

If the number of reactions required exceeds the number of wells in the reaction
plate, reduce the number of samples, Unknown replicates, Negative Control
replicates, Positive Control replicates, and/or Inhibition Controls.

IMPORTANT! A SEQ experiment provides a default plate layout. To modify the
default plate layout, refer to the Mycoplasma Real-Time PCR Detection Kit
Protocol for plate layout suggestions.
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(Optional) Review the run method

For more
information

* If you use Fast reaction tube strips (PN 4358293) for your reactions, a maximum
of 6 tube strips can be used in the 7500 Fast instrument (see page 40 for reaction
loading guidelines).

* Enter a sample volume per reaction. Applied Biosystems recommends a sample
volume per reaction of 10 UL for Mycoplasma SEQ experiments. The 7500 Fast
system supports total reaction volumes from 10 to 30 uL.

For more information on completing the Sample Setup screen, access the AccuSEQ
Software Help by clicking @ or pressing F1.

(Optional) Review the run method

About the example
experiment

Review the Run
Method screen

20

In the SEQ experiment workflow, the AccuSEQ software selects a thermal profile for
the instrument run that is optimized for the SEQ assay you select in step 4 on page 12.
You can review, but not edit, the pre-defined thermal profile in the Run Method screen.

Note: The SEQ experiment workflow automatically specifies the setup information
(experiment type, reagents, targets) and an optimized run method for the selected assay.

For the example Mycoplasma SEQ experiment, the pre-defined run method is
optimized for use with the Mycoplasma v1.0 SEQ assay.

Click Run in the navigation pane, then click Run Method. The thermal
profile displays the holding, cycling, and melt curve stages shown below.
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[ Run Method

Holding Stage Cycling Stage Melt Curve Stage

StepAndHold
Enable AutoDelta

Starting Cycle: [ |

100 —|

LN o
.

Step 1 Step 1 Step 2 Step 1 Step 2 Step 3
<
Legend

Data Collection On Data Collection OF A AutoDelta On A AuloDelta O

Note: For the example experiment, do not perform the run at this time.

~ Formore  For more information on the Run Method screen, access the AccuSEQ Sofiware Help
information by clicking @ or pressing F1.

Print the experiment and reaction setup

In the Print Experiment Setup screen, save and print the plate layout and the detailed
reaction setup instructions (the calculated volumes for preparing the samples, controls,
and PCR reactions) for the example experiment.

About the example Based on the setup information you entered in the Sample Setup screen (see page 15),
experiment  the reaction setup instructions for the example Mycoplasma SEQ experiment includes
the following information:
* The SEQ assay type is Mycoplasma Assay Software Module v1.0.
* The reaction volume per well is 30 uL with a 10% excess.
* The reaction components are:
— Power SYBR® Green PCR Master Mix (2X)
— Mpycoplasma Real-Time PCR Primer Mix (10X)
— Mpycoplasma Real-Time PCR DNA Control (positive control)
— Negative Control (water)
— Unknown sample DNA
*  Volume for all samples:
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Finish the experiment setup

— The premix solution volume per well is 18 pL.
— The final sample and control volume per well is 12 pL.

Print the Print the experiment setup (plate layout and detailed reaction setup instructions) for the
experiment setup  example experiment, then save the instructions for Chapter 3.

1. Click Setup in the navigation pane, then click [=2) Print Experiment Setup.

2. In the Print Experiment Setup screen, select the elements to include in the report:
* Experiment Summary
* Detailed Instructions
» Plate Layout

Print Experiment Setup

n Selectthe parts of the experiment setup to include. You can preview, save as a POF, and printthe selected contents. Click "Nest" to cantinue

What parts of the experiment setup do you want to include?

Experiment Summary Information ahout the experiment, including experiment name, experiment tyne, assay,
username, run information, electronic signature information, and comment.

Reaction Setup Instructions Awaork sheet containing the camponentvalumes needed far the number of samples and
controls specified

) Summary Instructions Summary instructions provide component volumes
(¥ Detailed Instructions  Detailed instructions provide step-by-step instructions and component volumes.

Plate Layout Anillustration of the wells in the reaction plate. Indicates the assay and sample assigned to
each well.

3. Click Print to print the report, or click Preview to display the report on-screen.

4. Specify a reason for change, if prompted. For more information, see “Security,
Audit and E-Signature (SAE) for users” on page 84.

5. Set the printed reaction setup instructions aside until you prepare the reactions
(see page 25).

For more  For more information on printing the plate layout and reaction setup instructions,
information  access the AccuSEQ Software Help by clicking @ or pressing F1.

Finish the experiment setup

To finish the experiment setup, select a save option.

Save the 1. At the bottom of the AccuSEQ software screen, click Save & Finish.
experiment

2. In the Save Experiment dialog box, verify the Mycoplasma SEQ Example
Setup.eds file name, then click Save.

22 AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide



Chapter 2 Set Up the Experiment 2
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& Save f‘?\
Save in: |E| experiments "I |E|‘EIEIE

i hMycoplasma SEQ Example.eds

{3 Presence Absence Example eds

My Recent E s0s57500fast-calib-hackground-96_05-28-2009-11001 2 eds
Documerts | |1 sds7500fast-calib-uniformity-06_05-28-2008-110105.eds
i sdsTa00fask-rnasep-96.eds

3 Standard Gurve Example.gds

e

o

~
o
=
=3
=

=

;
=]
:
:
L
=)
:
=
]

My Computer

| (el 2

File name:

Py Pletwsork : —
Places Files oftype: |Experlment Docurent Single files (F eds) ~| | cancel |

3. Specify a reason for change and sign the experiment, if prompted. For more
information, see “Security, Audit and E-Signature (SAE) for users” on page 84.

4. By default, the example experiment is saved to the <drive>:\Applied Biosystems\
AccuSEQ\experiments folder, and you are returned to the Run Method screen. For
the example experiment, do not perform the run at this time.

To continue with:

Examining the results of the example experiment, go to Chapter 5.

* Instructions for running your own Mycoplasma SEQ experiment using the
example experiment as a guide, go to Chapter 3.

Guidelines for your When you finish your own Mycoplasma SEQ experiment:

experiment . . .
P In the SEQ Experiment screen, select the appropriate save option:
Select/Click To...

File » Save Save the experiment using the current file name and

(or H in the toolbar) save location.

File » Save As... Save the experiment using a new file name and save
location.

File » Save as Template... Save the experiment as an SEQ template (*.edt file
type).

Save & Finish Save the experiment without making any further
changes and prepare to start the run.

* By default, experiments are saved to:
<drive>:\Applied Biosystems\AccuSEQ\experiments
To change the:

— Save location for a specific experiment — Navigate to the desired location
using the Save Experiment dialog box.
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— Default save location — Select Tools » Preferences, then select the Defaults
tab. In the Data Folder field, browse to then select the desired location.

IMPORTANT! Do not manipulate the experiment files stored on the hard drive of
the computer. If you do so, you will corrupt the experiment file and will not be
able to open it in the AccuSEQ software.

For more  For more information on using SEQ templates, see “SEQ template workflow” on
information  page 87.
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Prepare the Reactions

This chapter covers:

B Chapter OVEIVIEW . . ..ottt ettt e e e e e e e e et 26
Get Started
B Prepare the DNA template .. ... ... .. .. i, 27
B Prepare the samples . ........ ... ... 27
B Prepare the controls . ...... ... ... 28
B Prepare the premix solution . ......... .. ... .. .. i 30
Set Up the Experiment B Prepare the reactions. . . . .. ...ttt e 32
B Guidelines for your experiment . ............... ...t 34
l Note: For more information about any of the topics discussed in this guide, access the
Help system by pressing F1, by clicking @ in the toolbar of the AccuSEQ Software
Chapter 3 window, or by selecting Help » Contents and Index.

Prepare the Reactions

Run the Experiment

Review the Results Summary

(Optional) Review the Results

(Optional) Investigate the
Results
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Chapter overview

Chapter overview

This chapter explains how to prepare the PCR reactions for the example Mycoplasma
SEQ experiment and provides guidelines for preparing the PCR reactions for your own
Mycoplasma SEQ experiment.

Example The workflow for preparing the PCR reactions for the example experiment provided

experiment  with this getting started guide is shown below.
workflow

Start Experiment

v
Set Up the Experiment (Chapter 2)
v

Prepare the Reactions (Chapter 3)
1. Prepare the DNA template.
2. Prepare the samples.
3. Prepare the controls.
4. Prepare the premix solution.

5. Prepare the reactions.

v
Run the Experiment (Chapter 4)

v
Review the Results Summary (Chapter 5)

v
(Optional) Review the Results (Chapter 6)
v

(Optional) Investigate the Results (Chapter 7)

v
End Experiment
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Prepare the DNA template

Prepare the DNA template

About the example
experiment

Required materials

Prepare the
template

™

In this section, prepare the DNA template for the PCR reactions using the PrepSEQ
Mycoplasma Nucleic Acid Extraction Kit.

For the example Mycoplasma SEQ experiment, the template for the PCR reactions is
DNA extracted from bacteria found in test samples. There are 12 test samples to
analyze for the presence or absence of mycoplasma bacterial contaminants.

» The PrepSEQ™ Mycoplasma Nucleic Acid Extraction Kit for DNA isolation.

* Media, cell culture, or other source that you are testing for the presence of
mycoplasmas.

Refer to the PrepSEQ™ Mycoplasma Nucleic Acid Extraction Kit Protocol for details
on DNA isolation.

Prepare the samples

About the example
experiment

Required materials

Prepare the sample
dilutions

In this section, prepare the DNA samples (Unknowns) using the volumes that were
calculated by the AccuSEQ software (see page 21).

For the example Mycoplasma SEQ experiment:

* The sample volume per reaction is 10 pL.
* The excess reaction volume is 10%.

* Unknown sample DNA

* Negative Control (water)
* Microcentrifuge tubes

* Pipettors

* Pipette tips

* Vortexer

» Centrifuge

1. Label a separate microcentrifuge tube for each unknown sample:
+ Sample 1
* Sample 2

* Sample 12

2. Add the required volumes of each component to the appropriate sample tube:
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Volume (pL) for 2
Component Reactions*
Unknown sample DNA 22.0
Negative Control (water) 4.4
Total Sample Volume 26.4

T Includes 10% excess to compensate for pipetting errors.

3. Mix each sample by gently pipetting up and down, then cap each tube.
4. Vortex each sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the samples on ice until you prepare the reactions.

Prepare the controls

In addition to unknown samples, the control reactions required in a Mycoplasma SEQ
experiment are:

* Inhibition control — A minimum of one for each unknown sample

» Positive control — A minimum of one per plate

* Negative control — A minimum of one per plate

In this section, prepare the control reactions using the volumes that were calculated by
the AccuSEQ software (see page 21).

About the example For the example Mycoplasma SEQ experiment:

experiment 12 pL of each control (inhibition, positive, negative) is added to 18 uL of Premix

Solution.
* The final reaction volume per well is 30 pL.
* The excess reaction volume is 10%.
* The number of control wells in the reaction plate are:

Control Type Number of Wells
Inhibition 12%
Positive 2
Negative 2

T One inhibition control well for each unknown sample (see page 3)

Required materials Unknown sample DNA

*  Mycoplasma Real-Time PCR DNA Control (positive control)
* Negative Control (water)

* Microcentrifuge tubes

* Pipettors
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* Pipette tips
* Vortexer
» Centrifuge

~_ Prepare the 1. Thaw the Mycoplasma Real-Time PCR DNA Control (positive control)
inhibition control completely. Applied Biosystems recommends thawing the positive control at
37 °C for 5 minutes to ensure consistent results.

2. Vortex, then spin down the positive control.

3. Label a separate microcentrifuge tube for each inhibition control (one tube for
each unknown sample):

Sample Name Control Name
Sample 1 INHC 1
Sample 2 INHC 2
Sample 12 INHC 12

4. Add the required volumes of each component to the appropriate inhibition control

tube:
Volume (pL) for 1
Component Reaction*
Unknown sample DNA 11.0
Mpycoplasma Real-Time PCR DNA Control 2.2
Total Inhibition Control Volume 13.2

I Includes 10% excess to compensate for pipetting errors.

5. Mix each inhibition control by gently pipetting up and down, then cap each tube.
6. Vortex each inhibition control for 3 to 5 seconds, then centrifuge the tubes briefly.

7. Place the inhibition controls on ice until you prepare the reactions.

Prepare the 1. Make sure the positive control is thawed completely, then vortex and spin down
positive control the tube (see step 1 above).

2. Label an appropriately sized tube for the positive control: POS 1.

3. Add the required volumes of each component to the tube:

Volume (pL) for 2
Component Reactions*
Mpycoplasma Real-Time PCR DNA Control 4.4
Negative Control (water) 22.0
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Volume (pL) for 2
Component Reactions*
Total Positive Control Volume 26.4

T Includes 10% excess to compensate for pipetting errors.

4. Mix the positive control by gently pipetting up and down, then cap the tube.
5. Vortex the positive control for 3 to 5 seconds, then centrifuge the tube briefly.

6. Place the diluted positive control on ice until you prepare the reactions.

Prepare the 1. Label an appropriately sized tube for the negative control: NEG 1.
negative control

2. Prepare the negative control according to the following table:

Component Volume (uL) for 2

Reactions*
Negative Control (water) 26.4
Total Negative Control Volume 26.4

I Includes 10% excess to compensate for pipetting errors.

3. Centrifuge the tube briefly to spin down the contents and eliminate air bubbles.

4. Set the negative control aside until you prepare the reactions.

Prepare the premix solution

Prepare the premix solution using the components and volumes that were calculated by
the AccuSEQ software (see page 21). For a Mycoplasma SEQ experiment, you prepare
a premix solution that contains multiple primers designed to amplify the mycoplasma
targets and a reagent to detect amplification of the targets.

Note: The premix solution includes all components except unknown sample, positive

control DNA and negative control (water).

About the example  All samples contain the same primers for the bacterial target (mycoplasmas); therefore,
experiment  only one premix solution is required.

The premix solution components and volumes calculated in the software are:
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Component VOIUEL eagﬂgr:‘or 1
Power SYBR® Green PCR Master Mix (2X) 15.0
Mpycoplasma Real-Time PCR Primer Mix (10X) 3.0
Total Premix Solution Volume 18.0

Note: The sample is not added at this time.

Required materials * Premix solution components (listed above)
* Microcentrifuge tubes
* Pipettors
* Pipette tips
* Vortexer
* Centrifuge

Prepare the premix  For the following hazard, see the complete safety alert descriptions in Appendix B on
solution  page 89.

A WARNING! CHEMICAL HAZARD. Power SYBR® Green PCR Master
Mix.

1. Thaw all kit reagents completely.
2. Vortex, then spin down the reagents.
3. Label an appropriately sized tube for the premix solution: Premix Solution.

4. Prepare the premix solution according to the following table.

IMPORTANT! Use a separate pipette tip for the Power SYBR® Green PCR Master
Mix and the Mycoplasma Real-Time PCR Primer Mix.

Component VOI%";:éEt)n;%r 40
Power SYBR® Green PCR Master Mix (2X) 660.0
Mpycoplasma Real-Time PCR Primer Mix (10X) 132.0
Total Premix Solution Volume 792.0

T Includes 10% excess to compensate for pipetting errors.
5. Mix the premix solution by gently pipetting up and down, then cap the tube.

6. Centrifuge the tube briefly.
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7. Place the premix solution on ice until you prepare the reactions.

Prepare the reactions

Prepare the reactions using the volumes that were calculated by the AccuSEQ software
(see page 21).

About the example For the example Mycoplasma SEQ experiment:
experiment . ® . . .
A MicroAmp® Fast Optical 96-Well Reaction Plate is used.
* The reaction volume is 30 pL/well.
* The reaction plate contains:
— 24 Unknowns
— 12 Inhibition Controls
— 2 Positive Controls [
— 2 Negative Controls [ ]
» The following plate layout is used:

1 | 2 | 3 | 4 | 5 | & | 7 | 8 | ] | 10 | 1 | 12

Sampla 1 Sample 1 Sample 1 Sample 4 Sample 4 Sample 4 Sampls 7 Sample T Sampla 7 Sampla 10 Sample 10 Sample 10
A

Sample 2 Sample 2 Sample 2 Sample 5 Sample 5 Sample 5 Sample 8 Sample 8 Sample s Sample 11 Sample 11 Sample 11
8

sample 3 Sample 3 Sample 3 Sample o sample s Sample 0 Sample @ Sample 2 sample 9 Sample 12 Sample 12 Sampls 12
°
D
E
F
G

POS 1 POS 1 NEG 1 NES 1
N B mwcoptasma .. [ Myoopiasma [ Mycoptasma .. [ Mycopiasma
wiells: [ Unknown 24 [ Negative Control2 [ Positive Control2 [T Inhibition Control 12 56 Empty

Required materials » Samples and controls (from page 27)
* Premix solution (from page 30)
* Negative Control (water)

+  MicroAmp® Fast Optical 96-Well Reaction Plate (PN 4346906, also called a Fast
reaction plate)
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Prepare the reactions

»  MicroAmp® Optical Adhesive Film (PN 4311971)

* Pipettors
» Pipette tips
* Centrifuge

Prepare the  Use the plate layout and instructions to prepare the PCR reactions. Make sure the
reactions  arrangement of PCR reactions matches the plate layout in the software:

1. Add 18 pL of premix solution to the following wells: A1, A2, A3, A4, A5, A6,
A7, A8, A9, A10, Al11, A12,B1, B2, B3, B4, B5, B6, B7, B8, B9, B10,B11, B12,
C1,C2,C3,C4,C5,C6,C7,C8,C9,C10,C11,C12, H1,H2, H11, H12.

2. Prepare Sample reactions (Sample Type = UNKNOWN): Add 12 puL of unknown
sample DNA mixture (see ‘“Prepare the samples” on page 27) to the appropriate

wells.

Sample Name

Add 12 pL Sample

to Wells
Sample 1 Al, A2
Sample 2 B1, B2
Sample 3 C1,C2
Sample 4 A4, A5
Sample 5 B4, B5
Sample 6 C4,C5
Sample 7 A7, A8
Sample 8 B7, B8
Sample 9 C7,C8
Sample 10 A10, A11
Sample 11 B10, B11
Sample 12 C10, C11

3. Prepare Inhibition Control reactions (Sample Type = INHC): Add 12 uL of each
unknown sample and positive control DNA mixture (see “Prepare the inhibition
control” on page 29) to the appropriate wells.

Inhibition Add 12 pL Inhibition
Control Name Control to Well
INHC 1 A3
INHC 2 B3
INHC 3 C3
INHC 4 A6
INHC 5 B6
INHC 6 C6
INHC 7 A9
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Guidelines for your experiment

Inhibition Add 12 pL Inhibition
Control Name Control to Well
INHC 8 B9
INHC 9 C9
INHC 10 A12
INHC 11 B12
INHC 12 C12

4. Prepare Positive Control reactions (Sample Type = POS): Add 12 pL of positive

control DNA dilution (see “Prepare the positive control” on page 29) to wells H1
and H2.

5. Prepare Negative Control reactions (Sample Type = NTC): Add 12 pL of Negative
Control (water) to wells H11 and H12.

6. Seal the reaction plate with optical adhesive film (see page 35).
7. Centrifuge the reaction plate briefly to remove air bubbles.

8. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,

centrifuge the reaction plate again at a higher speed and for a longer period of
time.

IMPORTANT! Do not allow the bottom of the reaction plate to become dirty.
Fluids and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block and cause an abnormally high background signal.

Correct Incorrect
- [ [ 3
! |
| II
III ||
1 II
|III III
LJI _ (.
Liquid is at the Not centrifuged with enough force, or
bottom of the well. . .
Not centrifuged for enough time

9. Until you are ready to perform the run, place the reaction plate on ice in the dark.
Guidelines for your experiment

Reaction = When you prepare your own Mycoplasma presence/absence reactions:
preparation

guidelines * Include excess volume in your calculations to compensate for the loss that occurs
during reagent transfers.

* Include all required components.
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Guidelines for your experiment

+ Keep the Power SYBR® Green PCR Master Mix (2X) protected from light, in the
freezer, until you are ready to use it. Excessive exposure to light may affect the
fluorescent SYBR® Green I dye.

* Prior to use:
— Mix the master mix thoroughly by swirling the bottle.
— Resuspend the primer mix by vortexing, then centrifuge the tube briefly.

— Thaw the positive control DNA at 37 °C for 5 minutes to ensure consistent
results.

— Thaw frozen samples by placing them on ice. When thawed, resuspend the
samples by vortexing, then centrifuge the tubes briefly.

Experiment When you prepare your own Mycoplasma SEQ experiment:

reparation . : .
pgu‘?delines » Wear appropriate protective eyewear, clothing, and gloves.

* Make sure you use the appropriate consumables. If you use:

— Fast reaction plates (PN 4346906) — Seal the reaction plate with optical
adhesive film (PN 4311971)

— Fast reaction tube strips (PN 4358293) — Cover the tubes with optical caps
(PN 4323032)

» Make sure the arrangement of the PCR reactions matches the plate layout in the
AccuSEQ software. You can either:

— Accept the plate layout automatically generated by the AccuSEQ software.
or

— Use the Swap and Click-Drag controls available in the Plate Layout screen to
move samples to new well positions in the plate layout.

» Ifyou use optical adhesive film, seal each reaction plate as follows:
a. Place the reaction plate onto the center of the 96-well base (PN N8010531).
b. Load the reaction plate as desired.

c. Remove a single optical adhesive film (film) from the box.

Fold back one of the end-tabs. Hold the film with its
backing side up.

d. In one continuous movement, peel back the white
protective backing from the center sealing surface. Do
not touch the center sealing surface.

IMPORTANT! Improper peeling of the optical adhesive
film may result in haziness, but it does not affect results. Haziness disappears
when the film comes into contact with the heated cover in the instrument.
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Guidelines for your experiment

e. While holding the film by the end-tabs, lower the film
onto the reaction plate (adhesive side facing the reaction
plate). Be sure the film completely covers all wells of the
reaction plate.

f. While applying firm pressure, move the applicator
(PN 4333183) slowly across the film, horizontally and
vertically, to ensure good contact between the film and
the entire surface of the reaction plate.

d. While using the applicator to hold the edge of the film in
place, grasp one end of the end-tab and pull up and away
sharply. Repeat for the other end-tab.

h. Repeat step f to ensure a tight, evaporation-free seal.
While applying firm pressure, run the edge of the
applicator along all four sides of the outside border of the film.

Note: Optical adhesive films do not adhere on contact. The films require the
application of pressure to ensure a tight seal.

i. Inspect the reaction plate to be sure all wells are sealed. You should see an
imprint of all wells on the surface of the film.

For more For more information on:

information * Consumables — Refer to the Applied Biosystems 7500/7500 Fast Real-Time PCR
System Maintenance Guide.

+ Using Swap and Click-Drag controls to change the plate layout — Access the
AccuSEQ Software Help by clicking @ or pressing F1.
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Chapter 4

Run the Experiment

This chapter covers:

B Chapter OVEIVIEW . . ..ottt ettt e e e e e e e e et 38
Get Started
B Prepare fortherun .......... ... .. i 39
B (Optional) Enable the notification settings. . ............ .. ... .. ... ..... 40
B Startthe run. . ... ..o 42
B (Optional) Monitortherun. ...... ... .. .. . . i 42
Set Up the Experiment B Unload the instrument. . .. ... ... 47

Note: For more information about any of the topics discussed in this guide, access the
Help system by pressing F1, by clicking @ in the toolbar of the AccuSEQ Software
window, or by selecting Help » Contents and Index.

Prepare the Reactions

!

Chapter 4

Run the Experiment

Review the Results Summary

(Optional) Review the Results

(Optional) Investigate the
Results
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4 Chapter 4 Run the Experiment
Chapter overview

Chapter overview

This chapter explains how to perform a run on the Applied Biosystems 7500 Fast Real-
Time PCR System.

Example The workflow for running the example experiment provided with this getting started

experiment  gyide is shown below.
workflow

Start Experiment

v
Set Up the Experiment (Chapter 2)
v

Prepare the Reactions (Chapter 3)
v

Run the Experiment (Chapter 4)

1. Prepare for the run.

2. (Optional) Enable the notification settings.
3. Start the run.

4. (Optional) Monitor the run.

5. Unload the instrument.

v
Review the Results Summary (Chapter 5)

v
(Optional) Review the Results (Chapter 6)
v

(Optional) Investigate the Results (Chapter 7)

v
End Experiment
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Prepare for the run

Prepare for the run

Prepare for the run by opening the example experiment file you created in Chapter 2,
then loading the sealed reaction plate into the 7500 Fast instrument.

Open the example 1. Double-click ﬁ (AccuSEQ Software).
experiment
2. Enter your user name and password, then click OK.

Note: See your system administrator for user name and password.

3. Inthe Home screen, click Open Experiment.

4. In the Open dialog box, navigate to the experiments folder (default):
<drive>:\Applied Biosystems\AccuSEQ\experiments

5. Double-click Mycoplasma SEQ Example Setup.eds to open the example
experiment file you created in Chapter 2.

Load the reaction CAUTION! PHYSICAL INJURY HAZARD. During operation, the sample
plate into the block can be heated to 100 °C. Before performing the following procedure, be
Instrument sure to wait until the sample block reaches room temperature.

IMPORTANT! Wear powder-free gloves when you handle the reaction plate.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument with the notched A1 position
at the top-left of the tray. Ensure that the plate is properly aligned in the holder.

3. Push the tray door to close it. Apply pressure to the right side of the tray door at an
angle.
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(Optional) Enable the notification settings

Guidelines for your  IMPORTANT! Standard reaction plates and tube strips will not properly function and
experiment  mijght be crushed when using the Fast sample block.

When you load the reactions into the instrument, if you use:

» Fast reaction plates — Place the reaction plate in the plate holder with well A1 at
the back-left corner.

* Fast reaction tube strips — Place the tube strips in the plate holder for tube strips.

Note: For optimal performance with partial loads on a 7500 Fast instrument:

» Place empty tube strips in columns 1 and 12 to prevent crushing of tubes
containing samples.

» Place tube strips with samples in the plate holder vertically, starting in columns
6 and 7 and moving outward.

* A maximum of 6 tube strips can be used in the 7500 Fast instrument. Leave
columns 2, 3, 10, and 11 empty.

* Reaction tubes — Place the tubes in the plate holder.

IMPORTANT! Do not use MicroAmp® Fast Reaction Tubes (PN 4358297) in the
7500 Fast system.

(Optional) Enable the notification settings

Enable the notification settings so that the AccuSEQ software sends you e-mail when
the 7500 Fast instrument begins and completes the run, or if an error occurs during the
run. Enabling the notifications settings feature is optional and does not affect the
performance of the 7500 Fast system or the duration of the run.

IMPORTANT! The notification settings feature is available only if the computer that
you are using is running the 7500 Fast instrument and is connected to an Ethernet
network.

Note: Run notifications are saved per user.

About the example In the example experiment:
experiment
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(Optional) Enable the notification settings

* The AccuSEQ software is set up to send notifications when the 7500 Fast system
ends the run and if it encounters any errors during operation.

* The example outgoing mail server (SMTP) is not set up for secure sockets layer
(SSL) encryption and does not require authentication for use.

Set up notifications 1. Click @ Run in the navigation pane, then click (=} Notification Settings.
2. Select Yes to Enable Notifications.

3. Select the events that will trigger notifications:
* Instrument Error

*  Run Completed

4. Enter e-mail addresses for notifications.
For example: scientist@mycompany.com.

Note: Separate addresses with a comma (,).

5. Set the outgoing mail server settings:

a. Enter the name of the Outgoing Mail Server (SMTP).
For example: smtp.mycompany.com.

b. Leave the default Outgoing Mail Server Port Number (25).

6. Set the server authentication settings:
a. Select No for Server requires an encrypted connection.

b. Select No for Server requires authentication.

Notification Settings
2

|
Enable Motifications: @ Yes (O Mo
Select the events to generate notifications: Instrument Errar
3 [ Run Started

Run Completed

4 Enter e-rmail addresses for notifications: | scientist@rmveompany.corm
Separate e-mail addresses with commas
For example: user! @domain.com, userZ@domainZ.com

Outgaing Mail Server (SMTP): |smtp_mywmpanv com
5 Far exarple: smip.mycompany.com

Outgoing Mail Sereer Port Mumber: |25
For exarmple: 25

Server requires an encrypted connection? O Yes & No

Server requires authentication? O es & Mo
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Start the run

Guidelines for your When you set up the 7500 Fast system for automatic notification:

experiment
P Your system must be set up for network use. Refer to the Applied Biosystems

7500/7500 Fast Real-Time PCR System Maintenance Guide.

* Contact your systems administrator or information technology department if you
need:

— E-mail addresses for users who will receive notifications

— A network address for a simple mail transfer protocol (SMTP) server on the
LAN

— A port number for the server, if different from the default (25)
— A user name and password for the server, if required for access
— The Secure Sockets Layer (SSL) setting of the server (on or off)

Start the run

IMPORTANT! While the 7500 Fast instrument is performing a run, do not create
experiments, perform maintenance, print experiment data, or allow the computer to run
antivirus software or to enter hibernation mode. Performing such activities while the
instrument is running an experiment causes gaps in data collection.

To start your 7500 Fast instrument:
1. Click Eﬁé Run in the navigation pane.
2. Click START RUN [§ at the top of any run screen.

3. Specify a reason for change, if prompted. For more information, see “Security,
Audit and E-Signature (SAE) for users” on page 84.

(Optional) Monitor the run

You can view the progress of the run in real time as described below. During the run,
periodically view all three available plots (Amplification, Melt Curve, Temperature)
from the AccuSEQ software for potential problems.
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(Optional) Monitor the run

To... Action

Stop the run 1. In the AccuSEQ software, click STOP RUN.

2. In the Stop Run dialog box, click one of the following:
e Stop Immediately to stop the run immediately..

e Stop after Current Cycle/Hold to stop the run after the
current cycle or hold.

e Cancel to continue the run.
IMPORTANT! You cannot resume a run after you stop it.

View amplification data in Select M Amplification Plot.
real time See “About the Amplification Plot screen” on page 43.
View the melt curve in real Select Melt Curve.

time See “About the Melt Curve screen” on page 44.

View the temperature plot Select Temperature Plot.
during the run

View progress of the run in Select |: Run Method.
the Run Method screen See “About the Run Method screen” on page 45.
Enable/disable notifications = Select or deselect Enable Notifications.

in the Notification Settings

screen See “(Optional) Enable the notification settings” on page 40.

Note: You cannot change the sample setup or plate layout during a run.

About the The screen displays sample amplification (reporter signal) as your instrument collects
Amplification Plot  fluorescence data during a run. If a method is set up to collect real-time data, the
SCréeén  Amplification Plot screen displays the data for the wells selected in the Plate Layout
tab. The plot contrasts the change in normalized reporter signal (ARn) and cycle
number. The figure below shows the Amplification Plot screen as it appears during the
example experiment.

To view data in the Amplification Plot screen, select the wells to view in the Plate
Layout tab.
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(Optional) Monitor the run
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About the Melt
Curve screen

The Amplification Plot screen is useful for identifying and examining abnormal
amplification. Abnormal amplification can include the following:

* Increased fluorescence in negative control wells.

* Absence of detectable fluorescence at an expected cycle (determined from
previous similar experiments run using the same reagents under the same

conditions).

If you notice abnormal amplification or no signal in a well, troubleshoot the error as
explained in the AccuSEQ Software Help (click @ or press F1).

The screen displays sample amplification products (reporter signal) as your instrument
collects fluorescence data during a melt curve run, at the end of the cycling stage. If a
method is set up to collect melt curve data, the Melt Curve screen displays the data for
the wells selected in the Plate Layout tab. The plot contrasts normalized reporter signal
(Rn) and temperature ( °C). The figure below shows the Melt Curve screen as it

appears during the example experiment.

To view data in the Melt Curve screen, select the wells to view in the Plate Layout tab.
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About the Run
Method screen
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The Melt Curve provides the melting temperature (T,,) of each target (Target T,,)). The
T,, information is used by the AccuSEQ software, along with the cycle threshold (Cy)
and the derivative signal, to define the presence or absence of mycoplasma in the

Unknown sample.

The Melt Curve screen is also useful for identifying and examining non-specific
amplification. Non-specific amplification can include the following:

* Increased fluorescence in negative control wells.
* A melting temperature in the no-target range (No Target T,,).

If you notice non-specific amplification, troubleshoot the error as explained in the
AccuSEQ Software Help (click @ or press F1).

The screen displays the run method selected for the run in progress. The software
updates the Run Status field and displays progress bars throughout the run.

For Mycoplasma SEQ experiments:
* A pre-defined run method is used and cannot be edited.
* During the third stage, there is a delay between melting and completion of the

third stage while the system analyzes the data.

* The Results Summary displays after the run is complete (see Chapter 5).

The figure below shows the Run Method screen as it appears in the example

experiment.
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(Optional) Monitor the run

" Run Method

Halding Stage Cycling Stage Melt Curve Stage
Mumber of Gytles: Continuous () StepandHold
Enable AutoDelta
Staring Cycle:
100 —|
950°C 950°C 95.0°C 95.0°C
10.00 100% 00:15
75 —
0% 01:00 01:00
o |
25 —
o
Step 1 Step 1 Step 2 Step 1 Step 2 Step 3
4
Legend
Data Callection On Data Collection Off A AutoDelta On A AutoDelta OFf
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If an alert appears, click the error for more information and troubleshoot the problem
as explained in the AccuSEQ Software Help (click @ or press F1).
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Unload the instrument

Unload the instrument

When your 7500 Fast system displays the Run Complete message, unload the reaction
plate from the instrument.

Note: When the instrument completes a run, the system saves the details of the run to
the instrument log.

Unload the reaction & CAUTION! PHYSICAL INJURY HAZARD. During operation, the sample
plate

block can be heated to 100 °C. Before performing the following procedure, be
sure to wait until the sample block reaches room temperature.

IMPORTANT! Wear powder-free gloves when you handle the reaction plate.

1. Push the tray door to open it.
2. Remove the reaction plate.

3. Push the tray door to close it.

4. Discard the reactions as appropriate.
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Unload the instrument
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Get Started

Set Up the Experiment

Prepare the Reactions

Run the Experiment

!

Chapter 5

Review the Results
Summary

(Optional) Review the Results

(Optional) Investigate the
Results

Chapter 5

Review the Results Summary

This chapter covers:

B Chapter OVEIVIEW . . ..ottt ettt e e e e e e e e et 50
B Aboutthe analysisresults. .. ...ttt 51
B Review the Results Summary........... ... .. ... ... ... 52
B Exportandprintthedata........... ... ... ... i, 55

Note: For more information about any of the topics discussed in this guide, access the
Help system by pressing F1, by clicking @ in the toolbar of the AccuSEQ Software
window, or by selecting Help » Contents and Index.
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Chapter overview

Chapter overview

The AccuSEQ software automatically analyzes your data using information from the
instrument run. This chapter explains how to review the analysis results for the
example experiment using the Results Summary screen and how to export and print
data. If you receive questionable results, Chapter 6 explains how to further review the
results.

See “Navigation tips” on page 86 for information on navigating within the analysis
results screens.

Example The workflow for reviewing the example experiment data provided with this getting

experiment  started guide is shown below.
workflow

Start Experiment

v
Set Up the Experiment (Chapter 2)

v
Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v
Review the Results Summary (Chapter 5)

1. Review the Results Summary.

2. Export and print the data.

v

(Optional) Review the Results (Chapter 6)
v

(Optional) Investigate the Results (Chapter 7)

v
End Experiment
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About the analysis results

About the analysis results

About the analysis Immediately after the instrument run is complete, the AccuSEQ software automatically
analyzes the SEQ experiment data using pre-defined analysis settings optimized for the
selected SEQ assay, then displays presence/absence calls in the Results Summary on
your computer.

About the example  The AccuSEQ software automatically analyzes the example experiment data using the
experiment  default analysis settings for the mycoplasma target. To view the example Mycoplasma
SEQ experiment results, open the data file that installs with the AccuSEQ software.
The data file was created with the same design parameters that are provided in
Chapter 2, then run and analyzed on a 7500 Fast system.

You can find the data file for the example experiment on your computer:

1.

2.

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide

Double-click ﬁ (AccuSEQ Software).
Enter your user name and password, then click OK.

Note: See your system administrator for user name and password.

In the Home screen, click Open Experiment.

In the Open dialog box, navigate to the experiments folder (default):
<drive>:\Applied Biosystems\AccuSEQ\experiments

Double-click Mycoplasma SEQ Example.eds to open the example experiment
data file.

Note: The experiments folder contains several data files; be sure to select
Mycoplasma SEQ Example.eds.

3 Results in the navigation pane to view the run results.
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Review the Results Summary

# AccuSEQ™ Software v1.0 - Administrator,

File Edit Instrument Analysis Tools SAE Help

[i] NewExperiment - (5 Open.. [ Save + (3 Close 43 Export.. - Print Report... 4, E-Sig

Experiment Menu &

' Setup

Experiment: Mycoplasma SEQ Examp.

Assay: Mycoplasma 1.0

Results Summary

@ Usethe Call Summary,Plate Layout and Tasle view iment resLts. 1o view sample Infarmation and results, place the pointer on 3 well position

Call Summary

Positive Contrls 1 @ Expected 1 @ Unexpected
Negative Gontrols: 2 € Expected 0 € Unexpected
Unknowns: 7 € Present it 14 @ Absent 3 (4 Inconclusive

| 3 | 5 | B 7 | [] | []
q 5 q Sample 1 Sampled Sample 4 Sample7 Sample 7
14 Audit & E-Sig é Pt sampled PES sample7 2 I
trar e @ trzms trisese cromes
samplez Sample 5 samples 4 Sample &
jic] [ I jic}
trar o ) trze crzms
Sample 3 smplee samplee Sample Sample e
tron e @ tranrz triarsr craoz

Guidelines for your When you review your own Mycoplasma SEQ experiment:
experiment

* Open a Mycoplasma SEQ experiment that contains run data.
* Review the run results in the Results Summary (see page 53).

Note: Ifa well is incorrectly identified when you review results (for example, you
pipetted Sample 1 into the well labeled as Sample 2), you can move samples to the

correct well positions, then re-analyze. See the AccuSEQ Software Help for more
information.

(Optional) To further review results, view the Quality Summary (see page 59).

Review the Results Summary

Use the Call Summary, Plate Layout and Table views in the Results Summary screen to
review the experiment results.

About the example The presence/absence calls for the samples in the example Mycoplasma SEQ
experiment  experiment are:
e 24 Unknowns m — 7 Present, 14 Absent, 3 Inconclusive
* 12 Inhibition Controls I8 — 12 Expected
* 2 Positive Controls [] — 1 Expected, 1 Unexpected
* 2 Negative Controls [] — 2 Expected

For presence/absence call definitions, see page 53.

IMPORTANT! The Mycoplasma SEQ experiment performs a presence/absence assay.
The SEQ presence/absence assay is customized for detection of specific organisms and
species and may yield different results than a custom presence/absence assay.
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Review the Results Summary

The Call Summary at the top of the Results Summary screen lists a summary of results
for the wells in the reaction plate.

Review the
Call Summary

1. From the navigation pane, select %% Results » Results Summary.

2. Review the Call Summary for results:

Sample Type Call* Description
Positive Control, = ) Expected Target detected
Inhibiti trol
nhibition Gontro @ Unexpected = No target detected (target should be detected)
Negative Control @ Expected No target detected
6 Unexpected = Target detected (no target should be detected)
Unknown @ Present Target signal is present and is within the
temperature range, derivative range, and C;
range for the assay.
e Absent Target signal is not present within the
temperature range, derivative range, and C;
range for the assay.
) Inconclusive | The AccuSEQ software is unable to determine
a result.

1 Causes of an unexpected or inconclusive result are displayed in the Results Summary (see step 3
on page 54) and the Quality Summary (see page 59).

Review the results

Use the Plate Layout to display Mycoplasma SEQ assay presence/absence calls, and to
in the plate layout

select the data displayed in the Table View.

1. Select the Plate Layout tab in the Results Summary screen. The plate layout
displays call information about each well in the reaction plate in an illustration

(@2.0.0.@.0r )

1 —{CPlate Layout ] Table View |

SelectWells With: |- Select ltern - »

| @7 show inwalls ¥ | [ view Legend ‘ | |
v |2z [ =z [ 4« [ s | & [ 7 [ 8 [ a [ 1w | 1 [ 2
Sample 1 | Sample1 | Sample! | Sampled Sample 4 Sample 4 Sample 7 Sample? | Sample 7 | Sample 10 | Sample 10 | Sample 10
e & O @ O o ¢

A
e

CT: 2765 G 27.52 Cr 27328 Cr 3788 Cr: 2005 Cr: 3002 Cr: 2065 CT 3575 CT: 37.62 Cr: 2024

Sample2 | Sample2 | Sample2 Sample & Sample & | Sample 11 | Sample 11 | Sample 11

O O 0 & © s> 0 0 0 ©o

oo o m o o E ot ot B D b @

CT.27.76 CT27.74 Cr. 2877 CT: 386 Cr. 287 Cr.z88 CT. 3587 CT: 36.03 Cr.z958

Sample §
SEES Sample &

Sample 3 | Sampled Sample & Sample® | Sample® | Sample 12 | Sample 12 | Sample 12

Sample 3 | Sample3 Sample & Sample

Cr: 3001 Cr39.7 Cr: 3012 CT: 37.57 Cr: 3023 CT 35.21 CT: 36.11 Cr: 3034
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Review the Results Summary

2. In the Select Wells With drop-down list, select Sample Type, then select
Inhibition Control. The AccuSEQ software selects the associated wells in the
Plate Layout.

Plate Layout T Table Yiew ] —————
Selectwiells With: [Sample Type v Inhibition Control |
| ElshnmeeHsv | Wiew Legend ‘ ‘ |
[ 3 [ 6 R E o ] 12

Sample 1 Sample 1 | Sample 1 | Sampled Sample 4 Sample 4 Gample 7 Sample7 | Sample7 | Sample 40 | Sample 10 | Sample 10

. 2 2
m T i I i
Cm: 27 BS Cm: 27.52 CT: 27 38 Cr: 37.88 CT: 2895 CT:39.95 CT: 28 65 CT: 3575 C: 37 B2 CT: 29.84
Sample2 | Sample2 | Sample2 Sample 5 | Sample s Sample @ | Sample 41 | Sample 11 | Sample 14

Sample &5 Sample 2 Sample 8
: O|s & o |ad a6 e u

CT: 2776 Cr: 2774 Cr: 2077 CT: 226 Cr 207 CT:200 CT:35.07 CT: 2602 CT: 2082

Zample 3 | Zamples Zample & Zampled | Sampled | Sample 12 | Sample 12 | Sample 12
Sample3 | Sampled | oS e Samples | SoTE® Samaar ) | ASamble ample ample ample ample

IC m [IC m IC I I 1C
!30 a1 !39 7 !30 12 !37 57 !30 23 !35 21 !35 1 !30 34

While not present in the example experiment, an inhibition control (IC) well can
display an Unexpected result (%), indicating that inhibitors are present in the
unknown sample.

3. To display the call assessment for an unexpected or inconclusive result, place the
mouse pointer on a well. For the example experiment, display wells: A10, A11,
B11 and H2. The call assessment for well A11 is shown below.

[ 8 | 10 | m | 12 |

Sample 7 Sample 10 | Sample 10 Sample 10
£ £
Cr: 2065 CT:35.75 CT: 37,62 Cr:20.84
well: Al A 3
Sample Name: Sample 10
Sample Type:  Unknown

Call: Inconclusive

Call Assessment: Presumptive negative;
Cr: 3762

Assay: Mycoplasma Module w1.0

4. (Optional) To further review unexpected or inconclusive results, view the Quality
Summary (see page 59).

Review the results  Use the Table View to select, group or sort the results data for each well in the reaction
in the table view plate (see page 70).
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Export and print the data

Export and print the data

You can publish the experiment data in several ways:
» Export data
* Print the plate layout
* Create a slide of the plate layout
* Print a report

~ Formore  For information on performing these procedures, access the AccuSEQ Sofiware Help
information by clicking @ or pressing F1.
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Export and print the data
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Chapter 6

(Optional) Review the Results

This chapter covers:

B Chapter OVEIVIEW . . ..ottt ettt e e e e e e e e et 58
Get Started
B Aboutthe analysisresults. .. ...ttt 59
B Review the Quality Summary. . ........... ... i, 59
B Review the Amplification Plot. .. ... ... ... ... .. .. ... .. .. .. ... 62
B Reviewthe Melt Curve. . ... ot 67
Set Up the Experiment B Reviewthetabledata ........... .. .. ... .. i, 70
B Exportandprintthedata........... ... ... .. i, 72

Note: For more information about any of the topics discussed in this guide, access the
Help system by pressing F1, by clicking @ in the toolbar of the AccuSEQ Software
window, or by selecting Help » Contents and Index.

Prepare the Reactions

Run the Experiment

Review the Results Summary

l

Chapter 6

(Optional) Review the
Results

(Optional) Investigate the
Results
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Chapter overview

Chapter overview

Example
experiment
workflow

58

In addition to reporting the presence/absence calls in the Results Summary
immediately after an instrument run completes, the AccuSEQ software provides a call
assessment and troubleshooting information for any questionable results in the Quality
Summary. This chapter explains how to further review the analysis results of the
example experiment using the Quality Summary and several of the plot analysis
screens, and how to export and print data. If further investigation is required, Chapter 7
explains how to review the remaining plots and the analysis settings.

See “Navigation tips” on page 86 for information on navigating within the analysis
results screens.

The workflow for reviewing the analysis results for the example experiment data
provided with this getting started guide is shown below.

Start Experiment

v
Set Up the Experiment (Chapter 2)
v
Prepare the Reactions (Chapter 3)
v
Run the Experiment (Chapter 4)
v
Review the Results Summary (Chapter 5)
v
(Optional) Review the Results (Chapter 6)

1. Review the Quality Summary.
2. Review the Amplification Plot.
3. Review the Melt Curve.

4. Review the table data.

5. Export and print the data.

v
(Optional) Investigate the Results (Chapter 7)

v
End Experiment
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About the analysis results

About the analysis results

About the results

About the example
experiment

Guidelines for your
experiment

The Quality Summary provides a call assessment description and troubleshooting
information for any inconclusive or unexpected results shown in the Results Summary.
Use the Quality Summary table, the Amplification Plot and Melt Curve screens, and
the Table View tab to review the call assessments for the plate.

To review the example Mycoplasma SEQ experiment results, open the data file that
installs with the AccuSEQ software (see page 6). For the example experiment,
investigate the results for wells: A10, A11, B11 and H2.

When you review the results for your own Mycoplasma SEQ experiment:

* Open a Mycoplasma SEQ experiment that contains run data.
* Review the run results in the Results Summary (see Chapter 5).

* Review questionable results using the Quality Summary (see page 60), then
review the appropriate plots (see page 62).

* (Optional) To further investigate questionable results, see Chapter 7.

Review the Quality Summary

Possible call
assessments

The Quality Summary displays a list of the AccuSEQ software call assessments. This
summary includes the call assessment frequency and location for the open experiment.

For Mycoplasma SEQ experiments, the call assessments listed below may be triggered
by the experiment data.
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Review the Quality Summary

About the example
experiment

View the Quality
Summary

60

Call Assessment

Description

Unknown DNA in
negative control

Unknown DNA signal is detected in negative-control wells.

No expected DNA in
positive and/or inhibition
control

No expected DNA signal is detected in positive-control wells
and/or inhibition-control wells.

Presumptive positive*

Presumptive negative¥

Sample is determined to be presumptive positive.

Sample is determined to be presumptive negative.

Unexpected result in
inhibition control

Sample inhibits
amplification

The corresponding inhibition control(s) yield Unexpected result.

The unknown sample is negative and the inhibition control
shows a AC > 3 when compared to the positive control.

High background signal

The background fluorescence signal is higher than 500,000
fluorescent standard units (FSU).

Baseline algorithm failed

The software cannot calculate the best fit baseline for the data.

Thresholding algorithm
failed

The software cannot calculate a threshold.

Bad passive reference
signal

Fluorescence is offscale

Passive reference signal is abnormal.

Fluorescence exceeds the instrument's maximum detectable
range for one or more cycles.

All positive controls
failed

All positive controls yield Unexpected result.

All negative controls
failed

No inhibition control
found

All negative controls yield Unexpected result.

No inhibition control(s) found for the unknown sample.

Unable to determine the
SYBR call

The SYBR signal cannot be interpreted.

No signal in well

The well produced very low or no fluorescence.

C; algorithm failed

Exponential algorithm
failed

The software cannot calculate Cs.

The software cannot identify the exponential region of the
amplification plot.

1 Asample that is determined to be presumptive must be repurified, and the assay must be repeated. See

the MicroSEQ Mycoplasma Real-Time PCR Detection Kit Protocol for more information.

IMPORTANT! The Mycoplasma SEQ experiment performs a presence/absence assay.

The SEQ presence/absence assay is customized for detection of specific organisms and

species and may yield different results than a custom presence/absence assay.

In the example Mycoplasma SEQ experiment, you review the Quality Summary for

any call assessments generated by the experiment data. In the example experiment, call

assessments are generated for wells: A10, A11, B11 and H2.

1. Click |

Results in the navigation pane, then click

Zo/| Quality Summary.
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Review the Quality Summary

2. In the Quality Summary table, look in the Frequency and Wells columns to
determine which call assessments appear in the experiment.

3. Click a call assessment in the table to display more information about the
assessment. The call assessment for well A11 in the example experiment is shown
below.

Quality Summary

Call Asgessment Frequency Wells
Unknown DMA in negative contral
Mo expected DMA in positive and/ar inhibition control
Presumptive positive
3 Presumptive negative
Unahle to determine SYBR call
Unexpected result in inhibition control
Sarnple inhibits amplification
High background signal
Eageline algorithm failed
Thresholding algorithm failed
Bad passive reference signal
Exponential algorithrm failed
Al positive controls failed
Al nenative control failed

H2
A0, BT
A1

HEBEEEEEEEEEE

Call Assessment Presumptive negative

Description Sample is determined to be presumptive
negative

Wells A11
4 Wiew Troubleshooting Information

4. Click a troubleshooting link below the table to view information on correcting the
call assessment. The troubleshooting information for well A1l in the example
experiment is shown below.

E? Applied Biosystems AccuSEQ Software v1.0 Help ‘:”E‘El
N
Show  Back Fomard  Fiint
o
Presumptive Sample is determined Low concentrations of Regrow the culture for
nositive to be presumptive Mycoplasma in the an additional 24 hours,
nositive. samples, Repurify the sample and
repeat the experiment
using properly stored
assay components,
Unexpected The carrespanding The unknown sample is Repurify the sample and
result in inhibition contral{s) negative and the repeat the experiment,
inhibition vield Unexpected inhibition control shows
cantrol result, a ACT >3 when
compared ta the
positive contral.
Inhibitars were carried
over from the original
sample,
No positive contraol was Repeat the experiment
added to the inhibition with positive control
control well correctly added to
inhibition control well.
Incorrect volume of v

5. To investigate the data for results, review plots (see page 62).

Guidelines for your When you review your own Mycoplasma SEQ experiment:

i t . . . . .
experimen Click each call assessment in the Flag Details table with a frequency > 0 to display

detailed information about the call assessment.

* Ifneeded, click the troubleshooting link to view information on correcting the call
assessment.
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Review the Amplification Plot

~ Formore  For more information on the Quality Summary screen or on call assessments, access
information  the AccuSEQ Software Help by clicking @ or pressing F1.

Review the Amplification Plot

The amplification plot displays amplification of all samples in the selected wells.
There are three amplification plot views available:

* ARn vs Cycle — ARn is the magnitude of the normalized fluorescence signal
generated by the reporter at each cycle during the PCR amplification. This plot
displays ARn as a function of cycle number. You can use this plot to identify and
examine irregular amplification and to view threshold and baseline values for the
run.

* Rn vs Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. You can use this plot to identify and examine irregular
amplification.

* C;vs Well - C is the PCR cycle number at which the fluorescence signal equals
the threshold in the amplification plot. This plot displays C as a function of well
position. You can use this plot to locate outlying amplification (outliers).

About the example  You can examine the amplification plot to help with troubleshooting and quality
experiment  control. In the example Mycoplasma SEQ experiment, you review the amplification
plot for:

*  Cyvalues
» Irregular amplification

e Qutliers

View the 1. From the navigation pane, select Plot Analysis » Amplification Plot.
Amplification Plots

2. Display all 96 wells in the amplification plot by clicking the upper left corner of
the plate layout in the Plate Layout tab.

3. (Optional) For an expanded display of the Amplification Plot, click » in the
upper left corner of the plate layout in the Plate Layout tab.

62 AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide



Amplification Plot

Amplification Plot (ARn vs Cycle) r 7 7 3 T g 5 7 5 g 0 T H]

Chapter 6 (Optional) Review the Results
Review the Amplification Plot
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4. Seclect the Plot Settings tab, and adjust the plot display:

a
b.

o

From the Plot Type drop-down list, select ARn vs Cycle.
From the Graph Type drop-down list, select Linear.
From the Plot Color drop-down list, select Well.

(Optional) Deselect the Save current plot settings as the default for this
experiment checkbox.
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Review the Amplification Plot

Amplification Plot

R p alRE=

Amplification Plot (ARn vs Cycle)
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J Plot Settings | Options T Plot Legend 1 6

ot Type: (8RN vs Cycle v | Graph Type:|Linear v | Plot Color:fwel
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5. Select the Options tab, then select to show the Threshold (0.2).

Flot Settings TOptionsT Plot Legend 1

Target Mycoplasma Modulew!.0 w

[Show: [7] Threshald — [] Baseline Start: Well B0 Target & Baseline End: Vell (M Target 4«

6. (Optional) Select the Plot Legend tab to view the well colors assigned to each row
in the plate layout.

j Flot Settings T Options TPIot Legend}

LIS B @c Mo MWE HF Hc HH

7. Select wells in the plate layout to view in the amplification plot (see page 86 for
tips). For the example experiment, display the following replicate wells: A10-A12
(Sample 10), B10-B12 (Sample 11), H1-H2 (POS 1), and H11-H12 (NEG 1). The
amplification plots for wells A10-A12, H1-H2, and H11-H12 are shown below.
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Review the Amplification Plot
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While not present in the example experiment, an inhibition control (IC) well can
display a delay in amplification (C; value) as compared to the positive control
(POS) well(s), indicating that inhibitors are present in the unknown sample.

8. (Optional) To view an area of the amplification plot in detail, click:

a. A quadrant in the plot to the left of the area you want to review.

b. (Zoom in).
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Review the Amplification Plot

9. (Optional) Click §= (Hide the plot legend).

Note: This is a toggle button. When the legend is hidden, the button changes to
Show a legend for the plot.

Guidelines for your  When you review the amplification plot for your own Mycoplasma SEQ experiment,
experiment ook for:

* Outliers
* A typical amplification plot with four distinct sections:
a. Plateau phase

b. Linear phase

c. Exponential (geometric phase)

d. Baseline
10
1
0210658
o1 .Threshold
ARn
0.01
0.001 \v T | |
L ¥ e o |
RN 7 /[ g
™ AN iR \ LA WAl
0.0001 -
1]

24.3a1q12||¢|.\1amwxmoﬁ\119\4““4.149

d

Cycle

» Correct baseline and threshold values

IMPORTANT! Experimental error (such as contamination or pipetting errors) or
other reaction conditions can produce atypical amplification curves that can result
in incorrect baseline and threshold value calculations. Therefore,

Applied Biosystems recommends that you examine the Amplification Plot and
review the assigned baseline and threshold values for each unexpected and
inconclusive well after analysis completes.

If your experiment does not meet the guidelines above, you can:

* Adjust the baseline and/or threshold (see page 80).
or

*  Omit wells (see page 81).

~ Formore  For more information on the Amplification Plot screen, access the AccuSEQ Sofiware
information  Help by clicking @ or pressing F1.
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Review the Melt Curve
Review the Melt Curve

About the The Melt Curve plot displays the fluorescence peak data collected at each well position
Melt Curve  during the melt curve stage of an instrument run. For Mycoplasma SEQ experiments,
the AccuSEQ software determines the melting temperature (T,,) and reporter signal
(T,, height) for each peak.

Peaks in the melt curve can indicate the T, of the target (Target T,) or can identify
non-specific PCR amplification (No Target T ), where:

» The Target T, is the temperature at which 50% of the DNA is double-stranded and
50% of the DNA is dissociated into single-stranded DNA.

* The No Target T,, is a T, in the no-target range.

You can view the melt curve as normalized reporter (Rn) vs. temperature, or as
derivative reporter (-Rn') vs. temperature.

About the example In the example Mycoplasma SEQ experiment:

experiment  _ por the 24 UNKNOWN wells:
— The mycoplasma target is present in Samples 1, 2, 11 (one replicate), and 12.
— The mycoplasma target is absent in Samples 3, 4, 5, 6, 7, 8, and 9.

— The AccuSEQ software is unable to determine a result for Samples 10 and 11
(one replicate).

* There are no inhibited INHC wells.
*  One POS well produced an unexpected result.
» Al NTC wells produced expected results.

View the Melt Curve Click a sample in the plate layout or the well table to display the corresponding plots.
1. From the navigation pane, select Plot Analysis » Melt Curve.

2. (Optional) For an expanded display of the 96 wells of the Melt Curve, click % in
the upper left corner of the plate layout in the Plate Layout tab.

£| Plate Layout | Table View

>

| ElShowinWellsv | ViewLegend

3. In the Plot Settings tab, select:
a. Plot Type — Derivative Reporter
b. Target — Mycoplasma Module v1.0
c. Color — Well
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Melt Curve
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4. (Optional) Deselect the Save current plot settings as the default for this
experiment checkbox.

5. (Optional) Select the Plot Legend tab to view the well colors assigned to each row
in the plate layout.

6. (Optional) Click §= (Hide the plot legend).

Note: This is a toggle button. When the legend is hidden, the button changes to
Show a legend for the plot.

7. Select wells in the plate layout to view in the melt curve plot:
a. In the first Select Wells With drop-down list, select Sample Type.

b. In the second Select Wells With drop-down list, select:

+ Negative Control to view only NTC wells. The example experiment
contains expected results for both NTC wells.

+ Positive Control to view only POS wells. The example experiment
contains an unexpected result for one of the POS replicate wells.

68 AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide



Chapter 6 (Optional) Review the Results
Review the Melt Curve

Inhibition Control to view only INHC wells. The example experiment
contains expected results for all of the INHC wells.

Unknown to view only UNKNOWN wells. The example experiment
contains inconclusive results for three UNKNOWN wells.

The melt curve plot for the UNKNOWN wells in the example experiment is

shown below.
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The T,, value displayed below the melt curve plot is the T, associated with the largest
peak in the data, which may be the Target T, or the No Target T . You can determine

the Target T, by viewing the table data (see page 70).

Note: The T, value displayed below the plot may not exactly match the values
displayed in the well table because of rounding.

Guidelines for your When you review your own Mycoplasma SEQ experiment, review the Melt Curve plot

experiment  for:
The Target T, — The T,, is in the expected range.

The No Target T, — The T, is in the no-target range, which may indicate non-

specific amplification.
*  Unknown Calls:
— @ Present
— (@ Absent

-» Inconclusive
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Review the table data

» Control Well Calls:
— @ Expected
— € Unexpected

~ Formore  For more information on the Melt Curve screen, access the AccuSEQ Sofiware Help by
information  clicking @ or pressing F1.

Review the table data

The Table View displays results data for each well in the reaction plate, including:

* The well number, sample name, sample type, assay, call, call assessment, and
cycle 1 fluorescence (FSU)

* The calculated values: C, target T, target T, height, no-target T, , no-target T,
height, and ARn

Note: The cycle 1 fluorescence and ARn values are only available for display in
the Table View when it is accessed from the Plot Analysis screens.

About the example  For the example Mycoplasma SEQ experiment, group the wells in the Table View by:
experiment Call

» C(Call assessment

View the Table View 1. From the navigation pane, select Plot Analysis, then select the Table View tab.

2. (Optional) For an expanded display of the Table View, click < in the upper left
corner of the table in the Table View tab.

3. Use the Group By drop-down list to group wells by a specific category.
Note: You can select only one category at a time.

For the example experiment:

a. From the Group By drop-down list, select Call. Wells are listed in the order:
* Absent
* Expected
* Inconclusive
* Present
* Unexpected
*  Empty Well (no call)
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Review the table data

Select Wells With

- Selectliem-  w

Show in Tahle ¥ | Group By ¥
I well Position (Row)
# | wiell Position well Position (Column)
3a 1 = Absence !ZI cal

2 Ad [red

3 A5

4 a7 Sarmple Name

5 AR Sample Type:

B B4 Nane

7 BS ATpIE 9 ORRAGW

g BT Sample 8 Unknown

q BS Sample 8 Unknown
10 (3] Sample 3 Unknown
11 (v Sample 3 Unknown
12 4 Sample 6 Unknown
13 [sd} Sample 6 Unknown
14 c7 Sample 9 Unknown
149 [od:} Sample 9 Unknown
16 & Experted
17 A3 Sample 1 Inhibition Contral
18 AB Sample 4 Inhibition Contral
19 Ag Sample 7 Inhibition Contral
20 Al2 Sample 10 Inhibition Contral
21 B3 Sample 2 Inhibition Contral
22 BGB Sample 5 Inhibition Contral
23 B9 Sample 8 Inhibition Contral
24 B1z Sample 11 Inhibition Contral
24 c3 Sample 3 Inhibition Contral
26 o1} Sample 6 Inhibition Contral
27 (o] Sample 9 Inhibition Contral
28 c12 Sample 12 Inhibition Contral
29 H1 POS1 Positive Control
30 H11 MEG 1 MNegative Contral
3 H1z MEG 1 MNegative Contral
32 & Inconclusive
33 Al Sample 10 Unknown
34 Al Sample 10 Unknown
34 B11 Sample 11 Unknown
36 = Presence
37 Al Sample 1 Unknown
38 AZ Sample 1 Unknown
39 B1 Sample 2 Unknown
40 B2 Sample 2 Unknown
41 B10 Sample 11 Unknown
42 c10 Sample 12 Unknown
43 (0] Sample 12 Unknown
44 = Unexpected
45 H2 POS1 Positive Control

#  Well Position  Sample Mame

1 A10 Sample 10
2 B11 Sample 11
3 AN Sample 10
4 Hz POS1

5 Al Sample 1

Ct Call Call Assessment

37.584 Absence
Ahsence
Absence
30,982 Ahsence
Absence
38.605 Ahsence
Absence
Ahsence
Absence
Ahsence
39.7 Absence
Ahsence
Absence
37.573 Ahsence

27378 Expected
29.947 Expected
29.65 Expected
29.842 Expected
29773 Expected
29.703 Expected
29.904 Expected
29.796 Expected
30012 Expected
30119 Expected
30,226 Expected
30,343 Expected
30,226 Expected
39.723 Expected
39.37 Expected

35.746 Inconclusive Fresurmptive positive;
37616 Inconclusive Fresurmptive negative;
36.035 Inconclusive Fresurmptive positive;

27,65 Presence
7521 Presence
27.763 Presence
37743 Presence
35,975 Presence
35.208 Presence
36112 Presence

Unexpected Mo expected DNA N ..

In the example experiment:

TargetTm

79.084
79.439
79.439
79.439
79.439
TA616
TA616
79.439
79.439
79.734
79734
TA616
79.084

TA616
TA616
TA616

79.084
79.084
79.084
79.084
TA616
79.734
80143

Target Tm Height

Mo-Target Tm

72879
61.709
61.709
72879
61.886
72879
72347
72879
71.932
61.709
71.932
71.815
61.709
73234

72524

73.056

67.023
71.932
66.319
67.023
71.638
73.056
65,964

71.638

* Inconclusive — Unknown sample wells A10, A11, and B11

* Unexpected — Positive Control well H2

Mo-Target Tm Height

0.43

b. From the Group By drop-down list, select None. In the table, click the
column heading Call Assessment. Wells are sorted by the assigned call
assessment. Click the column heading again to reverse the sort order and
bring the wells with call assessments to the top of the table.

Unknown
Unknawn
Unknawin

Sample Twpe ct

35.746
36.035
37.616

Pasitive Control

Unknawin

27.65

Call
Inconclusive
Incanclusive
Incanclusive
Unexpected
Presence

Call Assessment A

Presumptive positive;
Presumptive positive;
Presumptive negative;
Mo expected DRNA In positive andfar inhibition contral;

In the example experiment:

Target Tm
T9.E16
79.616
79.616

79.084

Target Trn Height

Mo-Target Trn
721524
73.056
63.659
71.628
67.028

* Presumptive positive — Unknown sample wells A10 and B11

* Presumptive negative — Unknown sample well A1l
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Export and print the data

* No expected DNA in positive and/or inhibition control — Positive Control
well H2

Note: A sample that is determined to be presumptive must be repurified, and
the assay must be repeated. See the MicroSEQ Mycoplasma Real-Time PCR
Detection Kit Protocol for more information.

Guidelines for your When you review your own Mycoplasma SEQ experiment using the Table View:

experiment «  Group the wells by:

— Call - The software groups the called and uncalled wells. For a description of
the Mycoplasma presence/absence calls, see page 53.

— Call Assessment — The software groups the wells by call assessment. For a
description of the possible Mycoplasma call assessments, see page 59.

+ Review the following values for wells with inconclusive or unexpected results:
— Target T,, and Target T, height
— No-target T, and No-target T, height
- Cyp

* (Optional) To further investigate questionable results, see Chapter 7.

~ Formore  For more information on the Table View, access the AccuSEQ Software Help by
information  clicking @ or pressing F1.

Export and print the data

You can publish the experiment data in several ways:
» Export data
+ Save a plot as an image file
* Print a plot
* Print the plate layout
* Create slides
* Print a report

~ Formore  For information on performing these procedures, access the AccuSEQ Sofiware Help
information by clicking @ or pressing F1.
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2

Get Started

Set Up the Experiment

Prepare the Reactions

Run the Experiment

Review the Results Summary

(Optional) Review the Results

l

Chapter 7

(Optional) Investigate
the Results
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Chapter 7

(Optional) Investigate the Results

This chapter covers:

Chapter OVEIVIEW . . .ot i it ettt ettt et e ettt et e 74
About the analysis results . . .. ...t 75
Review the Multicomponent Plot . . ............. ... ... .. ... ....... 75
Reviewthe Raw DataPlot .. ........ ... ... ... .. ... .. .. .. . ... 77
Review the analysis settings . .. ..........co i, 80
Omit wells from the analysis ............ ... ... ... 81

Note: For more information about any of the topics discussed in this guide, access the
Help system by pressing F1, by clicking & in the toolbar of the AccuSEQ Software
window, or by selecting Help » Contents and Index.
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Chapter overview

Chapter overview

After you review any questionable results in the Quality Summary, Amplification plot,
and Melt Curve plot as explained in Chapter 6, you can investigate any questionable
results that require further examination using the remaining plot analysis screens. This
chapter explains how to further investigate the analysis results of the example
experiment using the Multicomponent and Raw Data plots, and how to review the
analysis settings and omit wells from the analysis.

See “Navigation tips” on page 86 for information on navigating within the analysis
results screens.

Example The workflow for investigating the analysis results for the example experiment data

experiment  provided with this getting started guide is shown below.
workflow

Start Experiment

<

Set Up the Experiment (Chapter 2)
v
Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v
Review the Results Summary (Chapter 5)

v

(Optional) Review the Results (Chapter 6)
v

(Optional) Investigate the Results (Chapter 7)

1. Review the Multicomponent Plot.
2. Review the Raw Data Plot.

3. Review the analysis settings.

4. Omit wells from the analysis.

v
End Experiment
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About the analysis results
About the analysis results

About the results  If you cannot determine the source of results identified as questionable in the Quality
Summary, use the Multicomponent and Raw Data plots to review the amplification
data for the plate, then edit the analysis (Cy) settings and omit wells from the analysis
as needed.

About the example  To investigate the example Mycoplasma SEQ experiment results, open the data file that
experiment  installs with the AccuSEQ software (see page 6). For the example experiment,
investigate wells: A10, A11, B11 and H2.

Guidelines for your  To investigate the example experiment and your own Mycoplasma SEQ experiment:

experiment . .
P * Open a Mycoplasma SEQ experiment that contains run data.

* Review the run results in the Results Summary (see Chapter 5).

+ If needed, review any questionable results in the Quality Summary (see page 59),
then review plots as needed (see page 62).

* Asneeded, investigate questionable results:
— Review the Multicomponent and Raw Data plots (see page 75).
— Review the analysis (Cy) settings (see page 80).
— Omit wells from the analysis (see page 81).

Review the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of a PCR run.

About the example In the example Mycoplasma SEQ experiment, you review the Multicomponent Plot
experiment o

+ SYBR® Green dye

+ ROX™ dye

* Spikes, dips, and/or sudden changes.

» Amplification in the negative control wells.

View the 1. From the navigation pane, select Plot Analysis » [|:3# | Multicomponent Plot.
Multicomponent

Plot 2. Select the Plot Settings tab, and adjust the plot display:
a. From the Plot Color drop-down list, select Dye.

b. (Optional) Deselect the Save current plot settings as the default for this
experiment checkbox.
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7 Chapter 7 (Optional) Investigate the Results
Review the Multicomponent Plot

3. (Optional) Select the Plot Legend tab to view the color assigned to each dye in
the experiment.

[ Plot Settings | Flof Legend | -3

[otcuor Dye v

[] Sawe current pldt settings as the default for this experiment

2b 2a
4. (Optional) Click §= (Hide the plot legend).

Note: This is a toggle button. When the legend is hidden, the button changes to
Show a legend for the plot.

5. Display the wells one at a time in the Multicomponent Plot screen:
a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen. The plot for well A11 ( = Inconclusive UNKNOWN) in the
example experiment is shown below.

Multicomponent Plot
iy &= =

Multicomponent Plot

Fluorescence

] 2 4 & i 100 120

Cycle
Plot Seftings | Plot Legend ]

svBr Il ROX
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Guidelines for your
experiment

For more
information

Chapter 7 (Optional) Investigate the Results 7
Review the Raw Data Plot

6. (Optional) For an expanded display of the Amplification Plot, click » in the
upper left corner of the plate layout in the Plate Layout tab.

7. Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the run.

8. Check the SYBR dye signal. In the example experiment, the SYBR dye signal
should not increase for NTC wells, if the call for an UNKNOWN well is Absent,
or if the call for a POS well is Unexpected. The SYBR dye signal should increase
for POS and INHC wells, or if the call for an UNKNOWN well is Present.

When you review your own Mycoplasma SEQ experiment, look for:

Passive reference (ROX dye)— The passive reference dye fluorescence level
should remain relatively constant throughout the PCR process.

* Reporter (SYBR dye) — The reporter dye fluorescence level should display a flat
region corresponding to the baseline. If target is present in the sample (a Present
call is made), the baseline will be followed by a rapid rise in fluorescence as the
amplification proceeds.

* Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescence.

* Negative control wells — There should not be any amplification in the negative
control wells.

For more information on the Multicomponent Plot screen, access the AccuSEQ
Software Help by clicking & or pressing F1.

Review the Raw Data Plot

About the example
experiment

View the Raw Data
Plot

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide

The Raw Data Plot screen displays the raw fluorescence (not normalized) for each
optical filter for the selected wells during each cycle of the real-time PCR.

In the example Mycoplasma SEQ experiment, you review the Raw Data Plot screen for
a stable increase in signal (no abrupt changes or dips) from the appropriate filter.

1. From the navigation pane, select Analysis » Raw Data Plot.

2. (Optional) Select the Plot Legend tab to view the well colors assigned to each row
in the plate layout.

3. Display all 96 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.
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Review the Raw Data Plot

-< Plate Layout | Table View
>
& =

| ElshowinWe\lsv | ViewLegend
3 i 2 [ s [ 4 ]

Sample 1 Sample 1  Sampled  Sampled

CTi2765 | CTm2752  Cm273% | CTa7es

A
J

4. In the Plate Layout tab, select wells corresponding to sample replicates. For the
example experiment:

» Uknown sample wells (including Inhibition Control wells) — From the Select
Wells with drop-down lists, select Sample Name and then select a sample
from the list (Sample 1 — Sample 12). For example, select Sample 10 from

the list:
Plate LayoutI Table View ]
Selectwiells with: Sample Mame » | [Sample 10 v 74
| ElshuwinWe\lsv | ViewLegend o

v [z [z [ 4 ] s [ & [ 7 [ & | & 10 11 12

Sample1 | Sample1  Sampled | Sampled Sample7 | Sample? | Sample 10 Sample 10 Sample 10

e 0O V!
m m E m oge®E g0 & @ m

Cr2766 | CrT2762 Cr2738 Cr.27.88 Cr.2005 CT2088 Crm2066 |CT3675 @ Cr3762 | Cr.2084

0

0!
(<
0

* Negative Control wells — From the Select Wells with drop-down lists, select
Sample Name and NEG 1.

* Positive Control wells — From the Select Wells with drop-down lists, select
Sample Name and POS 1.

5. Click and drag the Show Cycle pointer from cycle 1 to cycle 133, and review the
data from each filter:

+ The data from filter 1 correspond to the signal from SYBR® Green dye, the
reporter for the Mycoplasma target. Increase indicates amplification of the
target.

+ The data from filter 4 correspond to the signal from ROX"" dye, which is
used as the passive reference.

The filters are:

Filter 1 2 3 4 5
Dye(s) = FAM™ dye JOE™dye TAMRA™dye ROX"dye Cy™5dye
SYBR®Green @ VIC® dye NED™ dye Texas Red®
dye Cy™3 dye dye

The filter data from cycle 37 for Sample 10 (wells A11-A12) in the example
experiment are shown below.
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Guidelines for your
experiment

For more
information

Chapter 7 (Optional) Investigate the Results 7
Review the Raw Data Plot

Raw Data Plot

& =
Raw Data Plot

Amplitude

1000
10000
000

Options | Plot Legend

Show Cycle 37 —
e P
|1 0 100

6. Repeat step 4 and step 5 for each sample replicate.
7. (Optional) Click §= (Hide the plot legend).

Note: This is a toggle button. When the legend is hidden, the button changes to
Show a legend for the plot.

When you review the Mycoplasma SEQ experiment, look for the following in each
filter:

* Characteristic signal growth
* No abrupt changes or dips

For more information on the Raw Data Plot screen, access the AccuSEQ Sofiware Help
by clicking & or pressing F1.
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Review the analysis settings

Review the analysis settings

The Analysis Settings dialog box displays the pre-defined threshold cycle (C;) analysis
settings for Mycoplasma SEQ experiments, optimized in the AccuSEQ software for
use with the MicroSEQ Mycoplasma Real-Time PCR Detection Kit.

Note: For details on the Mycoplasma assay and detection kit, refer to the MicroSEQ
Mycoplasma Real-Time PCR Detection Kit Protocol.

About the example  In the example Mycoplasma SEQ experiment, the pre-defined analysis settings are
experiment  ysed without changes.

View the analysis Select Analysis » Analysis Settings to open the Analysis Settings dialog box.
settings
g For the example experiment, the pre-defined analysis settings are displayed in the C;

Settings tab:

# Analysis Settings for Mycoplasma SEQ Example Xl
| CT Settings
u Review the default setings for analysis oftargets in this experiment. To editthe default settings, click"Edit Default Settings” To use different settings for a target, select the target frorm the
table, deselect "Use Default Settings,” then change the setiings that are displayed.

Default Cr Settings

Default GT settings are used to calculate the G for targets without eustor setings. To et the defautt settings, click "Edit Default Settings.”
Threshold: 0.2 Baseline Start Cycle: 3 Baseline End Cycle: 15 | Edit Defaut Ssttings |
Select a Target CT Settings for Mycoplasma Module v1.0

Target Threshold Baseline Start Baseline End

CT Seftings 10 Use: [7] Use Default Setings
Mycaplasma Module v1.0 0.2 ‘3 15

v

Revert to Default Analysis Settings Lpply Analysis Setlings Cancel

Guidelines for your If the pre-defined analysis settings are not suitable for your experiment, you can
experiment  change the C; settings in the Analysis Settings dialog box, then re-analyze your
experiment. Use the C Settings tab to set the threshold and baseline either
automatically or manually.

IMPORTANT! C; settings are optimized for each assay. If you change settings,
particularly autobaseline, assay results may be affected.

Note: You must have administrator or scientist privileges to access these functions.
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Omit wells from the analysis

When you reset the threshold and baseline, keep the following Applied Biosystems
recommendations in mind:

Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:

e Above the background.

e Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select Start Cycle and End Cycle values so that the baseline ends
before significant fluorescence is detected.

- Formore  For more information on the analysis settings, access the AccuSEQ Software Help by
information  clicking @ or pressing F1 when the Analysis Settings dialog box is open.

Omit wells from the analysis

You may omit wells from analysis if you do not want to consider data generated by the
well.

Note: You must have administrator or scientist privileges to access this function.

About the example  In the example Mycoplasma SEQ experiment, there are no outliers; no wells need to be
experiment  removed from analysis.

Omit wells  To omit wells in your own Mycoplasma SEQ experiment:

1. Click Plot Analysis in the navigation pane. The software displays the
Amplification Plot screen by default.

2. In the Plate Layout tab, select one or more wells to omit from analysis (see
page 86 for tips).

Note: Alternatively, you can omit wells from the Table View. See the AccuSEQ
Software Help for more information.

3. Right-click the well(s), then select Omit. For example:
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Omit wells from the analysis

Plate Layout T Table View ]

experiment
1.
2.
3.
4.
5.
For more

information
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SelectWiells With: - Selecttem -~
| El Show in Wells ¥ | View Legend | |
[ 2 T ] 4 ] s ] e [ 7 ] & | 8 | 10 11 12
Sample 1 | Sample1 | Sample1 | Sample Sample 4 Sample 4 Sample 7 Sample7  Sample7  Sample 10 | Sample 10 | Sample 10
a e 0 o 4
o in
CT: 2765 C1: 27 52 CT: 2738 CT: 3788 CT: 2095 CT:3098 CT: 2065 CT: 3676 Cr: 3 z out
0om Oul
| Fit Plate
Sample2  Sample2  Sample2 | oo SampleS | Sampled oo gunpi g SAMPIRd  Sample 1 Sam r—
B 1
Omit
\—Q—l
CT2776 CT:2774 T 2077 T 386 T 207 1200 CT:3597 LT3 Include
[ ] Save As
Sample 3 Sample 3 Sample 3 SamPIEE Sample§ SamPIEE Sampled SamPIEB SamPIEB Sample 12 Sam| Print Preview
¢ e e c Print
m Ty
CT:30.01 CT:307 CT:30.12 C1: 37 .57 CT:30.23 CT: 3621 CT:36.11 CT:30.39

Results for the well are removed (indicated by [4]).

Click Analyze to re-analyze the data without the omitted wells.

Specify a reason for change, if prompted. For more information, see “Security,

Audit and E-Signature (SAE) for users” on page 84.

When you review your own Mycoplasma SEQ experiment, carefully consider which
wells to omit from analysis. If needed, remove outliers manually using the Table View.

From the navigation pane, select Plot Analysis » Amplification Plot.

In the Amplification Plot screen, select C vs Well from the Plot Type drop-down

list.

Select the Table View tab, then review the table data:

a. Look for any outliers.

b. Select the Omit check box next to the outlying well(s).

Click Analyze to re-analyze the experiment data with the outlying well(s)

removed from the analysis.

Specify a reason for change, if prompted. For more information, see “Security,

Audit and E-Signature (SAE) for users” on page 84.

For more information on omitting wells from the analysis, access the AccuSEQ
Software Help by clicking @ or pressing F1.



Appendix A

Reference Information

This appendix covers:

B Security, Audit and E-Signature (SAE) forusers........................ 84
B ONavigation tiPS . ..o vttt et et e e e e 86
B SEQ template workflow .. ....... ... . 87

Note: For more information about any of the topics discussed in this guide, access the
Help system by pressing F1, by clicking @ in the toolbar of the AccuSEQ Software
window, or by selecting Help » Contents and Index.
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Security, Audit and E-Signature (SAE) for users

Security, Audit and E-Signature (SAE) for users

The AccuSEQ Software includes security, audit, and electronic signatures features.
Depending on the way that your administrator configures these features, you may see
the following dialog boxes and prompts when you use the software:

Feature

Dialog Boxes and Prompts Description

Security

Audit

To access the software, you provide a user name
and password. If your system is configured for
periodic password expiration, you will periodically
be prompted to change your password. If your
system is configured to monitor consecutive
failed log in attempts, you will be locked out of the
software if you incorrectly enter your user name or
password for a specified number of times.

Exit Application

If your system is configured for auditing, you may
be prompted to specify a reason when you make
certain changes in the software.

& Specify Reason For Change fg|

Action Summarny

Additionally, you can generate and print an
experiment audit report that includes all audit

Data Untitled_data xls Exported ‘
records for an experiment.

Specify Reason

Selecta Reason:  |Mone |
Optionally, enter a qExperiment Reviewed

Experiment Approved
SOP Updated

| e

84
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Security, Audit and E-Signature (SAE) for users

Feature Dialog Boxes and Prompts Description
Electronic T — If your system is configured for electronic
Signature © E-Sig Verification signature, you may be prompted to provide your

i

Select an action, enter a cormment (optional),
@ enter your username and password, then
click "E-Sig."

Experiment. Untitled

Meaning
Review Edits
Comment
Y
W

| | | Cancel |

user name and password when you perform
certain actions in the software.

You can also sign an item on-demand (for
example, you can sign results after viewing them).

Note: The electronic signature function is
available only after an experiment contains data;
the E-Sig button is dimmed for new experiments.

If an item is set to require two signatures, the
signers are not required to sign at the same time.
When the first signer signs, the E-Sig status is set
to Partially Signed. When the second signer signs,
the E-Sig status is set to Signed.

Additionally, you can generate and print an
electronic signature report that all electronic
signature records for an experiment.

For more information on the SAE features available in the AccuSEQ software, refer to

the AccuSEQ Software Help.
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Navigation tips

H

86

Use the following procedures to navigate within the Results and Plot Analysis screens.

ow to select wells  To display specific wells in the analysis results screens, select the wells in the Plate
in the plate layout  Layout tab as follows:

1. To change the data displayed in the Plate Layout, click [@ Show in Wells, then
select (or deselect) the data to display in the plate layout.

2. To select wells of a specific type, use the Select Wells With drop-down lists:
Select Sample Name, Sample Type, or Assay, then select a sample name, sample
category, or assay name.

3. To select one well, click the well in the plate layout.

4. To select multiple wells, click and drag over the desired wells, or press Ctrl-click
or Shift-click in the plate layout.

5. To select all 96 wells, click the top left corner of the plate layout.

5 1 2

T_Plate Layout ] Table View ]

SelectWells With: |- Select ltern - »

[E Show In Wells ¥ | [ view Legend ‘ |
B v |2z [ =z [ 4« [ s | & [ 7 [ 8 [ a [ 1w | 1 [ 2
Sample 1 | Sample1 | Sample! | Sampled Sample 4 Sample 4 Sample? | Sample 7 | Sample 10 | Sample 10 | Sample 10

Sample 7
A (—] (— ) =) (/] e E 4

CT: 2765 G 27.52 Cr 27328 Cr 3788 Cr: 2005 Cr: 3002 Cr: 2065 CT 3575 CT: 37.62 Cr: 2024

Sample2 | Sample2 | Sample2 Sample & | Sample s Sample & | Sample 11 | Sample 11 | Sample 11

& e ey e e E e e e

CT.27.76 CT27.74 Cr. 2877 CT: 386 Cr. 287 Cr.z88 CT. 3587 CT: 36.03 Cr.z958

Sample 3 | Sampled Sample & Sample® | Sample® | Sample 12 | Sample 12 | Sample 12

Sample 3 | Sample3 Sample & Sample

oeeeeeee

Cr: 3001 Cr39.7 Cr: 3012 CT: 37.57 Cr: 3023 CT 35.21 CT: 36.11 Cr: 3034

How to display  Use the Multiple Plots view to display up to four plots simultaneously. To navigate
multiple plots  within the Multiple Plots view:

1. From the navigation pane, select E Plot Analysis Multiple Plots View.

2. To display four plots, click 55 Show plots in a 2 X 2 matrix.
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SEQ template workflow

3. To display two plots in rows (default view), click = Show plots in two rows.
4. To display two plots in columns, click /| Show plots in two columns.

5. To display a specific plot, select the plot from the drop-down list above each plot

display.
2B 4
[Amplification Plot - ARnvs Cycle v]
P palEE
Amplification Plot (ARn vs Cycle)
10
1
o1
o001
&
5 0.001
0.0001
0.00001
0.000001
0.0000001
o 2 4 6 8w & w W @ = @ & & wm % % & w a a
Cycle
Sample 3 Sample2 Sample 5 Sample 4 A
Samole 1 NEG 1 Samople 10 Samople 12 4
Mett curve v]

& Mk

Melt Curve (Normalized Reporter)

Mormaiized Reporter (Rn)

15

Tm: 80,
Temperature (°C)

Plot Settings | Plot Legend |

Plot Type: [Normalized Reporter v | Target [ v | calar [wen v

Save current plot settings as the default for this experiment

SEQ template workflow

You can use a SEQ template (*.edt file type) to create a new SEQ experiment (*.eds
file type). Templates allow you to create many experiments with the same setup
information.

Create atemplate 1. Double-click »% (AccuSEQ Software).
2. Enter your user name and password, then click OK.

Note: See your system administrator for user name and password.
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./ \ SEQ template workflow

Save a template as

88

an experiment

Create an
experiment with a
template

. Open an existing SEQ experiment (see page 39), or create a new SEQ experiment

(see page 12).

. Select File » Save As Template.

. Enter a file name, select a location for the template, then click Save.

Click &5 Close.

. In the Home screen, click Open Experiment.
. From the Files of Type list, select Experiment Document Template files (*.edt).
. Locate and select the template to use, then click Open.

. (Optional) Modify the setup information from the template, as needed:

* Experiment properties
» Sample setup
+ Plate layout

. Select File » Save As to save the template as an experiment (*.eds file type).
. Enter a file name, select a location to save the experiment. then click Save.

. Specify a reason for change, if prompted. For more information, see “Security,

Audit and E-Signature (SAE) for users” on page 84.

. Run the experiment, as needed.

. Select File » New Experiment » From Template.

. Locate and select the template to use (*.edt file type), then click Open. A new

experiment (*.eds file type) is created using the setup information from the
template:

» Experiment properties
» Sample setup
+ Plate layout

. (Optional) Modify the setup information from the template, as needed.
. Click [ Save to save the experiment.
. Enter a file name and select a location for the experiement, then click Save.

. Specify a reason for change, if prompted. For more information, see “Security,

Audit and E-Signature (SAE) for users” on page 84.

. Run the experiment, as needed.
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Symbols on instruments

Electrical The following table describes the electrical symbols that may be displayed on

symbols on  Applied Biosystems instruments.
instruments

Symbol Description

I Indicates the On position of the main power switch.

O Indicates the Off position of the main power switch.

Indicates a standby switch by which the instrument is switched on to the
Standby condition. Hazardous voltage may be present if this switch is on
standby.

Indicates the On/Off position of a push-push main power switch.

Indicates a terminal that may be connected to the signal ground reference of

J_— another instrument. This is not a protected ground terminal.
oy
D

Indicates a protective grounding terminal that must be connected to earth
ground before any other electrical connections are made to the instrument.

Indicates a terminal that can receive or supply alternating current or voltage.

Indicates a terminal that can receive or supply alternating or direct current or
>~ voltage.

Safety symbols The following table describes the safety symbols that may be displayed on
Applied Biosystems instruments. Each symbol may appear by itself or with text that
explains the relevant hazard (see “Locations of warnings” on page 91). These safety
symbols may also appear next to DANGERS, WARNINGS, and CAUTIONS that
occur in the text of this and other product-support documents.

Symbol Description

Indicates that you should consult the manual for further information and to
proceed with appropriate caution.

Indicates the presence of an electrical shock hazard and to proceed with
appropriate caution.

Indicates the presence of a hot surface or other high-temperature hazard
and to proceed with appropriate caution.

B> [>
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Symbol Description

Indicates the presence of a laser inside the instrument and to proceed with
appropriate caution.

Indicates the presence of moving parts and to proceed with appropriate
caution.

P [

Environmental The following symbol applies to all Applied Biosystems electrical and electronic
symbols on  products placed on the European market after August 13, 2005.

instruments
Symbol Description
Do not dispose of this product as unsorted municipal waste. Follow
é‘ local municipal waste ordinances for proper disposal provisions to reduce
\ = I the environmental impact of waste electrical and electronic equipment
(WEEE).
—0 European Union customers:

Call your local Applied Biosystems Customer Service office for equipment
pick-up and recycling. See www.appliedbiosystems.com for a list of
customer service offices in the European Union.

Locations of  The Applied Biosystems 7500 Fast Real-Time PCR System contains warnings at the
warnings  Jocations shown below.
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A Attention

Physical hazard

Physical hazard

Attention

Attention

Attention

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide



Appendix B Safety
Instrumentation safety

General instrument safety

ﬁ WARNING! PHYSICAL INJURY HAZARD. Use this product only as

specified in this document. Using this instrument in a manner not specified by
Applied Biosystems may result in personal injury or damage to the instrument.

WARNING! PHYSICAL INJURY HAZARD. Using the instrument in a
manner not specified by Applied Biosystems may result in personal injury or
damage to the instrument.

Moving and lifting
the instrument

CAUTION! PHYSICAL INJURY HAZARD. The instrument is to be moved
and positioned only by the personnel or vendor specified in the applicable site
preparation guide. If you decide to lift or move the instrument after it has been
installed, do not attempt to lift or move the instrument without the assistance of
others, the use of appropriate moving equipment, and proper lifting techniques.
Improper lifting can cause painful and permanent back injury. Depending on the
weight, moving or lifting an instrument may require two or more persons.

Moving and lifting ﬁ WARNING! Do not attempt to lift or move the computer or the monitor without

stand-alone
computers and
monitors

the assistance of others. Depending on the weight of the computer and/or the
monitor, moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:

Make sure that you have a secure, comfortable grip on the computer or the
monitor when lifting.

Make sure that the path from where the object is to where it is being moved is
clear of obstructions.

Do not lift an object and twist your torso at the same time.

Keep your spine in a good neutral position while lifting with your legs.
Participants should coordinate lift and move intentions with each other before
lifting and carrying.

Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Operating the  Ensure that anyone who operates the instrument has:

instrument

Received instructions in both general safety practices for laboratories and specific
safety practices for the instrument.

Read and understood all applicable Material Safety Data Sheets (MSDSs). See
“About MSDSs” on page 97.

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide 93



Appendix B Safety
Instrumentation safety

Cleat_‘ling_ or CAUTION! Before using a cleaning or decontamination method other than
decontaminating those recommended by the manufacturer, verify with the manufacturer that the
the instrument proposed method will not damage the equipment.

Physical hazard safety

Moving parts 2 WARNING! PHYSICAL INJURY HAZARD. Moving parts can crush and
cut. Keep hands clear of moving parts while operating the instrument.
Disconnect power before servicing the instrument.

Electrical safety

A WARNING! ELECTRICAL SHOCK HAZARD. Severe electrical shock can
result from operating the Applied Biosystems 7500 Fast Real-Time PCR System
without its instrument panels in place. Do not remove instrument panels. High-
voltage contacts are exposed when instrument panels are removed from the
instrument.

Fuses & WARNING! FIRE HAZARD. Improper fuses or high-voltage supply can
damage the instrument wiring system and cause a fire. Before turning on the
instrument, verify that the fuses are properly installed and that the instrument
voltage matches the power supply in your laboratory.

ii WARNING! FIRE HAZARD. For continued protection against the risk of fire,
replace fuses only with fuses of the type and rating specified for the instrument.

Power A WARNING! ELECTRICAL HAZARD. Grounding circuit continuity is
required for the safe operation of equipment. Never operate equipment with the
grounding conductor disconnected.

WARNING! ELECTRICAL HAZARD. Use properly configured and
approved line cords for the voltage supply in your facility.

é WARNING! ELECTRICAL HAZARD. Plug the system into a properly
grounded receptacle with adequate current capacity.

Overvoltage rating The Applied Biosystems 7500 Fast Real-Time PCR System system has an installation
(overvoltage) category of 11, and is classified as portable equipment.
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Workstation safety

Correct ergonomic configuration of your workstation can reduce or prevent effects
such as fatigue, pain, and strain. Minimize or eliminate these effects by configuring
your workstation to promote neutral or relaxed working positions.

CAUTION! MUSCULOSKELETAL AND REPETITIVE MOTION
HAZARD. These hazards are caused by potential risk factors that include but
are not limited to repetitive motion, awkward posture, forceful exertion, holding
static unhealthy positions, contact pressure, and other workstation environmental
factors.

To minimize musculoskeletal and repetitive motion risks:
* Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.

Safety and electromagnetic compatibility (EMC) standards

U.S. and Canadian
safety
standards

c(UL)us

Canadian EMC
standard

European safety
and EMC
standards

C€

AccuSEQ™ Real-Time PCR Detection Software Mycoplasma SEQ Experiments Getting Started Guide

This section provides information on:

+ U.S. and Canadian safety standards
* Canadian EMC standard

* European safety and EMC standards
* Australian EMC Standard

This instrument has been tested to and complies with standards:
* UL 3101-1/CSA 1010.1, “Safety Requirements for Electrical Equipment for
Measurement, Control, and Laboratory Use, Part 1: General Requirements.”

+ UL 61010-1/CSA C22.2 No. 61010-1, “Safety Requirements for Electrical
Equipment for Measurement, Control, and Laboratory Use, Part 1: General
Requirements.”

+ UL 61010-2-010, “Particular Requirements for Laboratory Equipment for the
Heating of Materials.”

This instrument has been tested to and complies with ICES-001, Issue 3: “Industrial,
Scientific, and Medical Radio Frequency Generators.”

Safety

This instrument meets European requirements for safety (Low Voltage Directive
73/23/EEC). This instrument has been tested to and complies with standards:

*+ EN61010-1:2001, “Safety Requirements for Electrical Equipment for
Measurement, Control and Laboratory Use, Part 1: General Requirements.”
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*+ EN61010-2-010, “Particular Requirements for Laboratory Equipment for the
Heating of Materials.”

*+ EN 61010-2-081, “Particular Requirements for Automatic and Semi-Automatic
Laboratory Equipment for Analysis and Other Purposes.”

EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 89/336/EEC). This instrument has been tested to and complies with standard
EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and
Laboratory Use — EMC Requirements.”

Australian EMC  This instrument has been tested to and complies with standard AS/NZS 2064, “Limits
Standard  and Methods Measurement of Electromagnetic Disturbance Characteristics of
0 Industrial, Scientific, and Medical (ISM) Radio-frequency Equipment.”
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General chemical safety

Chemical hazard WARNING! CHEMICAL HAZARD. Before handling any chemicals, refer to
warning the Material Safety Data Sheet (MSDS) provided by the manufacturer, and
observe all relevant precautions.

A WARNING! CHEMICAL HAZARD. All chemicals in the instrument,
including liquid in the lines, are potentially hazardous. Always determine what
chemicals have been used in the instrument before changing reagents or
instrument components. Wear appropriate eyewear, protective clothing, and
gloves when working on the instrument.

A WARNING! CHEMICAL STORAGE HAZARD. Never collect or store waste
in a glass container because of the risk of breaking or shattering. Reagent and
waste bottles can crack and leak. Each waste bottle should be secured in a low-
density polyethylene safety container with the cover fastened and the handles
locked in the upright position. Wear appropriate eyewear, clothing, and gloves
when handling reagent and waste bottles.

Chemical safety To minimize the hazards of chemicals:

guidelines Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page 97.)

* Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the MSDS.

+ Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.

MSDSs

About MSDSs  Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with
the first shipment of a hazardous chemical to a customer after an MSDS has been
updated. MSDSs provide the safety information you need to store, handle, transport,
and dispose of the chemicals safely.
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Chemical safety
Each time you receive a new MSDS packaged with a hazardous chemical, be sure to
replace the appropriate MSDS in your files.

Obtaining The MSDS for any chemical supplied by Applied Biosystems is available to you free
MSDSs 24 hours a day. To obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then select MSDS.

2. In the Keyword Search field, enter the chemical name, product name, MSDS part
number, or other information that appears in the MSDS of interest. Select the
language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of the
following:

*  Open — To view the document
* Print Target — To print the document

* Save Target As — To download a PDF version of the document to a
destination that you choose

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.

Chemical waste safety

Chemical waste ﬁ CAUTION! HAZARDOUS WASTE. Refer to Material Safety Data Sheets and
hazards local regulations for handling and disposal.

é WARNING! CHEMICAL WASTE HAZARD. Wastes produced by Applied
Biosystems instruments are potentially hazardous and can cause injury, illness,
or death.

WARNING! CHEMICAL STORAGE HAZARD. Never collect or store waste
in a glass container because of the risk of breaking or shattering. Reagent and
waste bottles can crack and leak. Each waste bottle should be secured in a low-
density polyethylene safety container with the cover fastened and the handles
locked in the upright position. Wear appropriate eyewear, clothing, and gloves
when handling reagent and waste bottles.

Chemical waste To minimize the hazards of chemical waste:

safety guidelines Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle, or
dispose of chemical waste.
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* Provide primary and secondary waste containers. (A primary waste container
holds the immediate waste. A secondary container contains spills or leaks from
the primary container. Both containers must be compatible with the waste material
and meet federal, state, and local requirements for container storage.)

* Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

* Handle chemical wastes in a fume hood.
+ After emptying a waste container, seal it with the cap provided.

» Dispose of the contents of the waste tray and waste bottle in accordance with good
laboratory practices and local, state/provincial, or national environmental and
health regulations.

Waste disposal If potentially hazardous waste is generated when you operate the instrument, you must:
» Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.
* Ensure the health and safety of all personnel in your laboratory.

* Ensure that the instrument waste is stored, transferred, transported, and disposed
of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

Biological hazard safety

General biohazard WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes but
is not limited to: protective eyewear, face shield, clothing/lab coat, and gloves.
All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and
company/institution requirements before working with potentially infectious
materials. Read and follow the applicable guidelines and/or regulatory
requirements in the following:

+ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories (stock no. 017-
040-00547-4; bmbl.od.nih.gov)

* Occupational Safety and Health Standards, Bloodborne Pathogens (29
CFR§1910.1030; www.access.gpo.gov/
nara/cfr/waisidx_01/29¢fr1910a_01.html).
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*  Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:
www.cdc.gov
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Safety alerts

For the definitions of the alert words IMPORTANT, CAUTION, WARNING, and
DANGER, see “Safety alert words” on page vii.

Specific chemical alerts

WARNING! CHEMICAL HAZARD. Power SYBR® Green PCR Master
Mix causes eye, skin, and respiratory tract irritation. Avoid breathing vapor. Use
with adequate ventilation. Avoid contact with eyes and skin.

Specific instrumentation alerts

CAUTION! PHYSICAL INJURY HAZARD. During operation, the sample
block can be heated to 100 °C. Before performing the procedure, be sure to wait
until the sample block reaches room temperature.
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absent result

amplification

amplification plot

amplification stage

assay

Audit

AutoDelta

Glossary

In Mycoplasma SEQ experiments, a sample result indicating that:
» Target signal is not present within the temperature range, derivative range, and C;
range for the assay.

» Passive reference is found, noise is below threshold, controls have "expected"
results.

The process of making copies of and thereby increasing the amount of a specific DNA
sequence.

Display of data collected during the cycling stage of PCR amplification. Can be viewed
as:

* Baseline-corrected normalized reporter (ARn) vs. cycle

* Normalized reporter (Rn) vs. cycle

» Threshold cycle (Cy) vs. well

Part of the instrument run in which PCR produces amplification of the target. The
amplification stage, called a cycling stage in the thermal profile, consists of
denaturing, primer annealing, and polymerization steps that are repeated.

For Mycoplasma SEQ experiments, fluorescence data collected during the
amplification stage are displayed in an amplification plot, and the data can be used for
troubleshooting.

In the AccuSEQ software, a predefined experiment designed to detect an organism or
group of organisms.

Administrator-configurable function that tracks the user, date, and time associated with
certain actions or changes made in the software. Can be set to prompt users to enter
reasons for change.

Audit reports can be viewed in the SAE Manager (administrators only) and the
Experiment window.

In a custom experiment run method, a setting to increase or decrease the temperature
and/or time for a step with each subsequent cycle in a cycling stage.

In SEQ experiments, AutoDelta is set to On and cannot be modified. In custom
experiments, AutoDelta can be turned On or Off.

When AutoDelta is enabled for a cycling stage, the settings are indicated by an icon in
the thermal profile:

e AutoDelta on: A
e AutoDelta off: &
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automatic baseline

automatic C;

baseline

baseline-corrected
normalized reporter
(ARn)

o
chemistry

custom experiment
workflow

cycle threshold
cycling stage

data collection

delta Rn (ARN)
derivative reporter
(-Rn’)

dissociation curve

104

An analysis setting in which the software calculates the baseline start and end values
for the amplification plot. You can apply the automatic baseline setting to specific
wells in the reaction plate. See also baseline.

An analysis setting in which the software calculates the baseline start and end values
and the threshold in the amplification plot. The software uses the baseline and
threshold to calculate the threshold cycle (Cy). See also threshold cycle (Cy).

In the amplification plot, a line fit to the fluorescence levels during the initial stages of
PCR, when there is little change in fluorescence signal.

The magnitude of normalized fluorescence generated by the reporter. In experiments
that contain data from real-time PCR, the magnitude of normalized fluorescence
generated by the reporter at each cycle during the PCR amplification. In the ARn vs.
Cycle amplification plot, ARn is calculated at each cycle as: ARn (cycle) = Rn (cycle)
— Rn (baseline), where Rn = normalized reporter.

See also normalized reporter (Rn).

See threshold cycle (Cy).

See reagents.

Workflow that allows you to design and run your own standard curve, melt curve, or
presence/absence experiment, including selecting experiment type, designating tasks

and targets, setting thermal cycling conditions, and performing data analysis.

Note: An experiment you create in the custom experiment workflow cannot be
accessed from the SEQ experiment workflow.

See threshold cycle (Cy).
See amplification stage.

A process during the instrument run in which an instrument component detects
fluorescence data from each well of the reaction plate. The instrument transforms the
signal to electronic data, and the data are saved in the experiment file. In the AccuSEQ
software, a data collection point is indicated by an icon in the thermal profile:

+ Data collection on:

* Data collection off:
See baseline-corrected normalized reporter (ARn).
The negative first-derivative of the normalized fluorescence generated by the reporter
during PCR amplification. In the derivative reporter (—Rn") vs. temperature melt curve,

the derivative reporter signal is displayed in the y-axis.

See melt curve.
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electronic signature
(E-Sig)

expected result

experiment

experiment name

holding stage

inconclusive result

inhibition control

manual baseline

manual Cy

Glossary

Administrator-configurable electronic signature function. Signatures (user name and
password) can be applied on demand. The software can also be configured to require
signatures to save, print, and/or export experiment data. Can be turned on or off.

E-Sig reports can be viewed in the SAE Manager (administrators only) and the
Experiment window.

In Mycoplasma SEQ experiments, a control result indicating:

» Positive control — Target detected
* Negative control — No target detected
* Inhibition control (Mycoplasma assay) — Target detected

Refers to the entire process of performing a run using the 7500 Fast instrument,
including setup, run, and analysis.

Entered during experiment setup, the name that is used to identify the experiment.
Experiment names cannot exceed 100 characters and cannot include any of the
following characters: forward slash (/), backslash (\), greater than sign (>), less than
sign (<), asterisk (*), question mark (?), quotation mark ("), vertical line (]), colon (%),
or semicolon (;).

In the thermal profile, a stage that includes one or more steps and is used to activate
enzymes, to inactivate enzymes, or to incubate a reaction.

In SEQ assay experiments, the holding stage is not editable.

In Mycoplasma SEQ experiments, a sample result indicating that the AccuSEQ
software is unable to determine a result.

Causes of an Inconclusive result are displayed in the Results Summary and the Quality
Summary.

A reaction solution that includes the Power SYBR® Green PCR master mix, the
unknown sample, and the positive control (Mycoplasma Real-Time PCR DNA
control). Monitors for inhibitors in the unknown sample (inhibition in the presence of a
positive target). A minimum of one inhibition control is required per sample.

An analysis setting in which you enter the baseline start and end values for the
amplification plot. You can apply the manual baseline setting to specific wells in the
reaction plate.

An analysis setting in which you enter the threshold value and select whether to use
automatic baseline or manual baseline values. The software uses the baseline and the
threshold values to calculate the threshold cycle (Cy).
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melt curve

melt curve stage

melting
temperature (T,,)

multicomponent
plot

Mycoplasma Real-
Time PCR DNA
Control

negative control
(NC)

no template control
(NTC)

no target T,
normalized reporter
(Rn)

omit well

passive reference

plate layout
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A plot of the derivative of the fluorescence versus temperature. Peaks in the melt curve
can indicate the melting temperature (T,,) of the target (Target T,,) or can identify
nonspecific PCR amplification (No Target T,,). You can view the melt curve as
normalized reporter (Rn) vs. temperature or as derivative reporter (—Rn”) vs.
temperature. Also called dissociation curve.

In the thermal profile, a stage with a temperature increment to generate a melt curve.

In Mycoplasma SEQ and custom melt curve experiments, the temperature at which
50% of the DNA is double-stranded and 50% of the DNA is dissociated into single-
stranded DNA. The T, is displayed in the melt curve.

A plot of the complete spectral contribution of each dye for the selected well(s) over
the duration of the PCR run.

In Mycoplasma SEQ experiments: A specially designed plasmid DNA used as the
positive control whose amplification mimics the expected amplification of a
mycoplasma target. Target signal that is not detected in a positive-control well indicates
a pipetting error, possible inhibition, or a problem with amplification. A minimum of
one positive control is required per run.

A reaction solution that contains water or buffer instead of sample template. Monitors
for contamination (unexpected amplification in the absence of a target) and reagent
integrity. A minimum of one negative control is required per run. Also called no
template control (NTC).

See negative control (NC).

In Mycoplasma SEQ experiments: A T, in the no-target range can indicate nonspecific
PCR amplification.

Fluorescence signal from the reporter dye normalized to the fluorescence signal of the
passive reference.

An action that you perform before reanalysis to omit one or more wells from analysis.
Because no algorithms are applied to omitted wells, omitted wells contain no results.

A dye that produces fluorescence. Because the passive reference signal should be
consistent across all wells, it is used to normalize the reporter dye signal to account for
non-PCR related fluorescence fluctuations caused by minor well-to-well differences in
concentrations or volume. Normalization to the passive reference signal allows for high
data precision.

An illustration of the grid of wells and assigned content in the reaction plate. In the
7500 Fast system, the grid contains 8 rows and 12 columns.
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plot color
Polymerase Chain
Reaction (PCR)
positive control

Power SYBR®
Green PCR Master
Mix

present result

premix solution

primer

primer mix

ramp

raw data plot

reaction mix

reagents

real-time PCR

Glossary

In the AccuSEQ software, you can use the plate layout as a selection tool to assign well
contents, to view well assignments, and to view results. The plate layout can be printed,
included in a report, exported, and saved as a slide for a presentation.

In Mycoplasma SEQ experiments, a color assigned to a sample in Sample Setup to
identify the sample in the plate layout and analysis plots.

Technology used to increase the amount of a DNA sequence.

See Mycoplasma Real-Time PCR DNA Control.

The master mix used to prepare the premix solution. It contains the DNA polymerase
enzyme that initiates PCR in the presence of the necessary primers and DNA sample. It
also contains SYBR® Green I dye, which binds to double-stranded (ds) DNA, thus
providing a fluorescence signal that indicates the amount of dsSDNA product generated
during PCR.

In Mycoplasma SEQ experiments, a sample result indicating that target signal is
present and meets the following conditions:

» Within the temperature range, derivative range, and C range for the assay.

» Passive reference is found, noise is below threshold, positive and negative controls
have "expected" results.

See reaction mix.

A segment of DNA that is complementary to the target DNA sequence and is needed to
start amplification.

PCR reaction component that contains the forward primer and reverse primer designed
to amplify the target.

The rate at which the temperature changes during the instrument run. Except for the
melt curve step, the ramp is defined as a percentage. For the melt curve step, the ramp
is defined as a temperature increment. In the graphical view of the thermal profile, the
ramp is indicated by a diagonal line.

A plot of raw fluorescence signal (not normalized) for each optical filter.

A solution that contains all components to run the PCR reaction, except for the
template (sample, standard, or control). Also called premix solution.

The PCR reaction components you are using to amplify the target and to detect
amplification.

Process of collecting fluorescence data during PCR.
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region of interest Type of 7500 Fast system calibration in which the system maps the positions of the

(ROI) calibration wells in the sample block. ROI calibration data are used so that the software can
associate increases in fluorescence during a run with specific wells in the reaction
plate.

replicates Total number of identical reactions containing identical samples, components, and
volumes.

reporter A fluorescent dye used to detect amplification. For SYBR® Green reagents, the

reporter dye is SYBR® Green dye.

Rn See normalized reporter (Rn).

ROX™ dye A dye supplied by Applied Biosystems and calibrated on the 7500 Fast systems. ROX
dye is used as the passive reference.

run method Definition of the reaction volume and the thermal profile for the 7500 Fast instrument
run.

sample The template that you are testing.

SAE Manager Controls Security, Audit, and E-Sig functions and reporting.

sample type In SEQ experiments, the identifier you assign to a well in Sample Setup.

Sample Type options are:

[ Unknown
« & POS (positive control)
« [ NTC (negative control)

* Mycoplasma SEQ experiments: If you specify inhibition controls for samples,
each sample is assigned inhibition control wells (.

Security Administrator-configurable function that controls user access to the software, manages
user accounts, and determines security policies.

SEQ experiment Step-by-step workflow for a specific Applied Biosystems assay. The SEQ experiment

workflow workflow calculates reagent volumes, determines optimum plate setup, guides you
through experiment set up, uses optimized thermal cycling conditions, and performs
data analysis.

Note: An experiment you create in the SEQ experiment workflow cannot be accessed
from the custom experiment workflow.

SEQ template An experiment document template file (*.edt) that includes setup information
(experiment properties, sample setup, run method, and plate layout) for a specific
Applied Biosystems assay.
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stage
SYBR® Green

reagents

system dye

target

target T,

template

thermal profile

threshold

threshold cycle (Cy)

T

m

Glossary

In the thermal profile, a group of one or more steps. There are three types of stages:
holding stage, cycling stage (also called amplification stage), and melt curve stage.

PCR reaction components designed to amplify the target and SYBR® Green dye to
detect double-stranded DNA.

Dye supplied by Applied Biosystems and calibrated on the 7500 Fast instrument.
Before you use system dyes in your experiments, make sure the system dye calibration
is current in the Instrument Maintenance Manager.

System dyes of the 7500 Fast instrument include:

+ CY3dye

*+ CYS5dye

« FAM™ dye
+ JOE™ dye
« NED™dye
+ ROX™ dye

+ SYBR® Green dye
« TAMRA™ dye

+ TEXAS RED® dye
+ VIC® dye

The nucleic acid sequence that you want to amplify and detect.

In Mycoplasma SEQ experiments: The temperature at which 50% of the DNA is
double-stranded and 50% of the DNA is dissociated into single-stranded DNA. The T,
displayed in the melt curve is the T, associated with the largest peak, which may be the
Target T, or the No Target T ..

The type of nucleic acid to add to the PCR reaction. The recommended template varies
according to experiment type. For Mycoplasma SEQ experiments, Applied Biosystems
recommends adding DNA templates to the PCR reactions.

Part of the run method that specifies the temperature, time, ramp, and data collection
points for all steps and stages of the 7500 Fast instrument run.

1. In amplification plots, the level of fluorescence above the baseline and within the
exponential growth region The threshold can be determined automatically (see
automatic Cy) or can be set manually (see manual Cy).

2. In presence/absence experiments, the level of fluorescence above which the
software assigns a presence call.

The PCR cycle number at which the fluorescence meets the threshold in the
amplification plot.

See melting temperature (T,,), no target T, target T,
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Glossary

unexpected result In Mycoplasma SEQ experiments, a control result indicating:
* Positive control — No target detected (target should be detected)
* Negative control — Target detected (no target should be detected)
* Inhibition control (Mycoplasma assay) — No target detected (target should be
detected)

Causes of an unexpected result are displayed in the Results Summary and the Quality
Summary.

unknown A DNA sample from media, cell culture, or other source that you are testing for the
presence of mycoplasmas.
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Documentation

About the System documentation

The documents listed below are shipped with the Applied Biosystems 7500 Fast Real-
Time PCR System (7500 Fast system) using the AccuSEQ Real-Time PCR Detection
Software (AccuSEQ software).

Guide Purpose and Audience PN
Applied Biosystems AccuSEQ™ Real- Explains how to perform Mycoplasma SEQ experiments on the = 4425587
Time PCR Detection Software 7500 Fast system. The documents function as both a:
Asﬂt); f_?e’yaémzeSEQ Experiments Getting e Tutorial, using example experiment data provided with the
AccuSEQ software.
Applied Biosystems AccuSEQ™ Real- e Guide for your own experiments. 4425586
Time PCR Detection Software o )
Mycoplasma SEQ Experiments Quick Intended for laboratory staff and principal investigators who
Reference Card perform Mycoplasma SEQ experiments using the 7500 Fast
system.
Applied Biosystems AccuSEQ™ Real- Explains how to perform custom experiments on the 7500 Fast 4425585
Time PCR Detection Software Custom system. The Quick Reference Card functions as both a:
Experiments Quick Reference Card e Tutorial, using example experiment data provided with the
AccuSEQ software.
e Guide for your own experiments.
Intended for laboratory staff and principal investigators who
perform custom experiments using the 7500 Fast system.
Applied Biosystems 7500/7500 Fast Real- = Explains how to maintain the 7500 Fast system. 4412844
Time PCR System Maintenance Guide Intended for laboratory staff responsible for the maintenance of
Applied Biosystems 7500/7500 Fast Real- | the 7500 Fast system. 4387778
Time PCR System Computer Setup Guide
Applied Biosystems Real-Time PCR Provides information about the reagents you can use on 4387787
Systems Reagent Guide Applied Biosystems Real-Time PCR Systems, including:
¢ Anintroduction to TagMan® and SYBR® Green reagents
e Descriptions and design guidelines for the following custom
experiment types:
— Quantitation (standard curve) experiments
— Presence/absence experiments
Intended for laboratory staff and principal investigators who
perform custom experiments using the 7500 Fast system.
Applied Biosystems 7500/7500 Fast Real- | Explains how to prepare your site to receive and install the 7500 = 4412843

Time PCR System Site Preparation Guide

Fast system.

Intended for personnel who schedule, manage, and perform the
tasks required to prepare your site for installation of the 7500
Fast system.
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Documentation
Related documentation

Guide Purpose and Audience PN

Applied Biosystems AccuSEQ™ Software = Explains how to use the AccuSEQ software to: NA

v1.0 Help e Set up and manage the security, audit, and electronic

signature settings on the 7500 Fast system.

e Set up, run, and analyze SEQ and custom experiments using
the 7500 Fast system.

e Calibrate a 7500 Fast instrument.

e \Verify that the performance of a 7500 Fast instrument with
an RNase P run.

Intended for:

e Principal investigators who are responsible for controlling
access to the 7500 Fast system.

e Laboratory staff and principal investigators who perform
experiments using the 7500 Fast system.

e Laboratory staff responsible for the installation and
maintenance of the 7500 Fast system.

Related documentation

Table 1 Documents Related to Mycoplasma SEQ Experiments

Document PN
PrepSEQ™ Mycoplasma Nucleic Acid Extraction Kit Protocol 4401253
PrepSEQ™ Mycoplasma Nucleic Acid Extraction Kit Quick Reference Card 4406304
MicroSEQ® Mycoplasma Real-Time PCR Detection Kit Protocol 4393111

MicroSEQ® Mycoplasma Real-Time PCR Detection Kit Quick Reference Card 4393471

Table 2 Documents Related to Custom Standard Curve Experiments

Document PN
PrepSEQ™ Residual DNA Sample Preparation Kit Protocol 4415259
resDNASEQ™ Quantitative CHO DNA Kit Protocol 4415260
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Documentation
Obtaining information from the Help system

Table 3 Documents Related to the Reagent Guide

Document PN

Introduction to Tagman® and SYBR® Green Chemistries for Real-Time PCR 4407003
Protocol

Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575

Custom TagMan® Gene Expression Assays Protocol 4334429
Custom TagMan® Genomic Assays Protocol: Submission Guidelines 4367671
Power SYBR® Green PCR Master Mix and RT-PCR Protocol 4367218
Primer Express® Software Version 3.0 Getting Started Guide 4362460
SYBR® Green PCR and RT-PCR Reagents Protocol 4304965
SYBR® Green PCR Master Mix and RT-PCR Reagents Protocol 4310251

Note: For additional documentation, see “How to obtain support” on page ix.

Obtaining information from the Help system
The AccuSEQ software has a Help system that describes how to use each feature of the
user interface. Access the Help system by doing one of the following:
* Click @ in the toolbar of the AccuSEQ software window.
* Select Help » AccuSEQ Software Help.
* Press F1.
You can use the Help system to find topics of interest by:

* Reviewing the table of contents
» Searching for a specific topic
» Searching an alphabetized index

Send us your comments

Applied Biosystems welcomes your comments and suggestions for improving its user
documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is for submitting comments and suggestions
relating only to documentation. To order documents, download PDF files, or for help
with a technical question, see “How to obtain support” on page ix.
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Numerics
7500 Fast system, filters 78

A

absent result 53
amplification curve 66
amplification plot
description 62
viewing 62
Amplification Plot screen
monitor during a run 43
open 62
analysis results
investigate 74
review 58
analysis results screens, about 4
analysis settings
edit 80
review 80
Applied Biosystems
customer feedback on documentation 113
Information Development department 113
assumptions for using this guide viii
audit 84
audit report 84

B

baseline, edit 81
biohazardous waste, handling 99
bold text, when to use ix

C

call assessments
display in wells 54
group by in table 71
Mycoplasma SEQ experiment 59
Call Summary 53
calls, group by in table 70
CAUTION, description vii
chemical safety 97
chemical waste safety 98
click-drag wells 35
controls

calls 70

minimum number 10, 28

prepare. See prepare
conventions

bold text ix

for describing menu commands ix

IMPORTANTS! ix

in this guide ix

italic text ix

Notes ix

user attention words ix
create

experiment 12

experiment from template 88

template 87
CT settings

edit 80

guidelines 81

review 80
curves, amplification 66
Custom Experiment 5

Index

customer feedback, on Applied Biosystems documents 113

D

DANGER, description vii
data files, example experiment 6
default analysis settings 51, 80
DNA template 27
documentation

related 112

system 111

E

edit
analysis settings 80
baseline 81
threshold 81

electrical, safety 94

electromagnetic compatibility standards. See EMC

standards
electronic signature. See e-sig
e-mail notification 41
EMC standards 95
ergonomics, safety 95
e-sig
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Index

about 85
experiment 23
report 85
example experiment
analysis results 51, 59, 75
analysis settings 80
calls 52
controls 28
create 12
data files 6
description 4, 5, 15
DNA template 27
investigate analysis results 74
name 13, 39, 51
open 39, 51
plate layout 6, 32
review data. See review
run 38
run method 20, 45
run notifications 40
sample dilutions 27
save location 23
workflow 8§, 11, 26, 38, 50, 58, 74
expected result 53
experiment
analyze 52, 80, 82
create from template 88
create new 12
description 2
e-sig 23
guidelines. See guidelines
open 39, 51, 88
print data. See print
properties 13
run method, Mycoplasma SEQ 3, 10
save 22
save location 23
sign 23, 85
experiment setup
define experiment properties 13
finish 22
print 21
workflow 11
experiment type 10
export, results 55, 72

F

features, software 2
filters, 7500 Fast system 78

G

guidelines
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analysis settings 80
chemical safety 97
chemical waste disposal 98
chemical waste safety 98
CT settings 81

experiment preparation 35
experiment setup 14, 19
experiment, about 5

load instrument 40
prepare reactions 34
review 52,59, 61, 66, 69, 72, 75,77, 79, 82
run notifications 42

save experiment 23

H

hazard icons. See safety symbols, on instruments 90
hazard symbols. See safety symbols, on instruments
hazards. See safety

Help system, accessing 113

home screen 12

IC 17
image, save plot as 72
IMPORTANT, description vii
inconclusive result 53, 71, 76
Information Development department, contacting 113
inhibition control

add to wells 33

prepare 29

select in plate 54

select in plot 69
installation category 94
instrument

load 39

unload 47
instrument operation, safety 93
investigate analysis results, workflow 74
italic text, when to use ix

K

kit
Mycoplasma, about 3
PrepSEQ, about 6, 27

L

load instrument
guidelines 40
reaction plate 39

login 12, 39, 51, 84, 87



M

Melt Curve screen

monitor during a run 44

open 67
melt curve, about 67
menu commands, conventions for describing ix
monitor run

Amplification Plot screen 43

Melt Curve screen 44

Run Method screen 45
moving and lifting safety

computers and monitors 93

instrument 93
moving parts, safety 94
MSDSs

about vii

description 97

obtaining ix, 98
multicomponent plot 75

description 75

viewing 75
Multicomponent Plot screen, open 75
multiple plots view 87
Multiple Plots View screen, open 86
multiple plots, displaying 86
Mycoplasma detection system, about 2
Mycoplasma kit, about 3, 29
Mycoplasma SEQ experiment

call assessments 61

reactions 3

run method 3, 10

workflow 2

N

navigation tips 86
negative control 77

add to wells 34

prepare 30

select in plot 68
no target Tm 67
Notification Settings screen, open 41
notification settings. See run notifications
notifications. See run notifications

)

omit wells 81
online Help. See Help system
open
Amplification Plot screen 62
example experiment 39, 51

Index

experiment 39, 51, 88

Melt Curve screen 67
Multicomponent Plot screen 75
Multiple Plots View screen 86
Notification Settings screen 41
Print Experiment Setup screen 22
Quality Summary screen 60
Raw Data plot screen 77
Results Summary screen 53
Run Method screen 20

Table View 70

overvoltage category (rating) 94

P

passive reference dye 77
password 84, 85
physical hazard, safety 94
plate layout 6
add controls 33, 34
add premix solution 33
add samples 33
click-drag wells 35
example experiment 32
omit wells 81
print 21, 55, 72
review results 53
select wells 86
swap wells 17, 35
view 16
plot
amplification, results 62
amplification, run 43
colors, set 16
melt curve, results 67
melt curve, run 44
multicomponent 75
multiple plots view 87
raw data 77
save as image 72
temperature, run 43
positive control
add to wells 34
prepare 29
select in plot 68
thawing 29
predefined settings, about 10
premix solution
add to wells 33
description 30
prepare 31
prepare
for run 39
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Index

inhibition control 29 Raw Data plot 75
negative control 30 review. See review
positive control 29 sign 85
premix solution 31 Results Summary screen, open 53
reactions. See prepare reactions Results Summary, review 50
prepare reactions review
about 32 amplification plot 62
guidelines 34 analysis results 58
workflow 26 analysis settings 80
PrepSEQ kit, about 6, 27 Call Summary 53
present result 53 CT settings 80
presumptive negative result 60, 71 guidelines 52, 59, 61, 66, 69, 72, 75, 77, 79, 82
presumptive positive result 60, 71 melt curve 67
print multicomponent plot 75
audit report 84 Quality Summary 59, 60
e-sig report 85 raw data plot 77
experiment setup 21 Results Summary 50
plate layout 21, 55, 72 table data 54, 70
reaction setup 21 ROX dye 75, 77,78
results 55, 72 run experiment
Print Experiment Setup screen, open 22 alerts 46
enable notification settings. See run notifications
Q monitor 42
prepare for 39
Quality Summary screen, open 60 start 42
Quality Summary, review 59 stop 43
workflow 38
R run method
Mycoplasma SEQ experiment 3

radioactive waste, handling 99

raw data plot view 20
description 77 Run Me.thod screen
filter data 79 monitor during a run 45
viewing 77 open 20

run method, Mycoplasma SEQ experiment 10
run notifications
enable 40

Raw Data Plot screen, open 77
reaction plate

layout 6 _
load into instrument 39 example experiment 40
sealing 35 guidelines 42
unload from the instrument 47 setup 41
reaction setup, print 21
reaction volume 10, 20, 21, 28, 32 S
reactions SAE (security, audit, e-sig), about 84
Mycoplasma SEQ experiment 3 safety
prepare 32 before operating the instrument 93
repetitive motion, safety 95 biological hazards 99
reporter dye 10, 77 chemical 97
results chemical waste 98
call assessments 59 electrical 94
export 55,72 ergonomic 95
Multicomponent plot 75 guidelines 97, 98, 99
print 55, 72 instrument operation 93
Quality Summary 59 moving and lifting computers and monitors 93
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moving and lifting instrument 93
moving parts 94
physical hazard 94
repetitive motion 95
standards 95
workstation 95
safety labels, on instruments viii
safety standards 95
safety symbols, on instruments 90
sample
dilutions 27
names, enter 15
volume 20
sample names, enter 16
Sample Setup screen 15
sample volume 15, 21, 27
samples, add to wells 33
save
experiments 22
plot as image 72
template as experiment 88
security 84
selecting wells 16
SEQ assay 12, 14
SEQ experiment type 10, 14
SEQ experiment. See experiment
SEQ template. See template
sign (electronic)
experiment 23
results 85
slides, creating 55, 72
standards
EMC 95
safety 95
swap wells 17, 35
SYBR Green dye 3, 6, 10, 35, 75, 77, 78
symbols, safety 90

T

Table View 54
about 70
omit wells 82
open 70
viewing 70
TaqMan reagents 78
target
calls 69
name 30
target Tm 67
Temperature plot. See plot
template

Index

create 87
create experiment from 88
save as 23
save as experiment 88
workflow 5, 87
text conventions ix
threshold
edit 81
select in plot 64
training, information on ix
troubleshoot, call assessments 59, 61

U

unexpected result 53, 71
unknown, select in plot 69
unload instrument 47
user attention words, described ix
using this guide

as a tutorial 4

with your own experiments 5

W

WARNING, description vii
waste disposal, guidelines 99
waste profiles, description 99
wells
call assessments, display 54
click-drag 35
negative control 15, 77
omitting 81
positive control 15
selecting 16, 86
swap 17,35
unknown 15
workflow
example experiment 8, 11, 26, 38, 50, 58, 74
experiment setup 11
investigate analysis results 74
Mycoplasma SEQ experiment 2
prepare reactions 26
review analysis results 58
review Results Summary 50
run experiment 38
template 5, 87
tutorial 4
workstation, safety 95
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